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Introduction

To get maximum versatility from this machine all operators should carefully read and follow the instruc-

tions in this manual. Please keep this manual in a handy place near the machine.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-

able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-

ating the machine.

Software Version Conventions Used in this Manual

• NetWare 3.x means NetWare 3.12 and 3.2.

• NetWare 4.x means NetWare 4.1, 4.11 and IntranetWare.

Trademarks

Apple, AppleTalk, EtherTalk, LaserWriter, Macintosh and Mac are registered trademarks of Apple

Computer, Inc.

Ethernet is a registered trademark of Xerox Corporation.

Microsoft, Windows and Windows NT are registered trademarks of Microsoft Corporation in the United

States and/or other countries.

Netscape and Netscape Navigator are registered trademarks of Netscape Communications Corpora-

tion.

Novell, NetWare and NDS are registered trademarks of Novell, Inc.

PostScript is a registered trademark of Adobe Systems, Incorporated.

Sun is a registered trademark of Sun Microsystems, Inc.

SunOS is a trademark of Sun Microsystems, Inc.

Other product names used herein are for identification purposes only and might be trademarks of their

respective companies. We disclaim any and all rights in those marks.

Note

The proper names of the Windows operating systems are as follows:

• The product name of Windows® 95 is Microsoft® Windows 95.

• The product name of Windows® 98 is Microsoft® Windows 98.

• The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).

• The product names of Windows® XP are as follows:

Microsoft® Windows® XP Professional

Microsoft® Windows® XP Home Edition

• The product names of Windows® 2000 are as follows:

Microsoft® Windows® 2000 Advanced Server

Microsoft® Windows® 2000 Server

Microsoft® Windows® 2000 Professional

• The product names of Windows NT® 4.0 are as follows:

Microsoft® Windows NT® Server 4.0

• Microsoft® Windows NT® Workstation 4.0
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Manuals for This Machine

The following manuals describe the operational procedures and maintenance of
this machine.

To enhance safe and efficient operation of this machine, all users should read
and follow the instructions carefully.

❖❖❖❖ Printer Reference 1
Describes the system settings, procedures and functions for using this ma-
chine. This manual is also included as a PDF file on the CD-ROM labeled
“Printer Drivers and Utilities”.

❖❖❖❖ Printer Reference 2
Describes the procedures and provides necessary information about using
this machine. This manual is included as a PDF file on the CD-ROM labeled
“Printer Drivers and Utilities”.

❖❖❖❖ Network Printing Guide (this manual)
Describes the procedures and provides necessary information about setting
up and using the machine under the network environment. We recommend
this manual as your first choice to read, and it is included as a PDF file on the
CD-ROM labeled “Printer Drivers and Utilities”.
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:

This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:

This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.

* The statements above are notes for your safety.

Important

If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation

This symbol indicates the prior knowledge or preparations required before op-
erating.

Note

This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference

This symbol indicates a reference.

[ ]

Keys that appear on the machine's display panel.

Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's control panel.

Keys on the computer's keyboard.
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Introduction

This manual contains detailed instructions on configuring the machine as a net-
work printer. Read the section appropriate to your network environment on
how to configure the machine correctly.

Important

❒ The procedures written in this manual assume that you are a network admin-
istrator. If you are not, be sure to consult your network administrator before
configuration.

❖❖❖❖ Features

• Support for 100BASE-TX and 10BASE-T

• The Network Interface Board is compatible with Windows 95/98/Me
(TCP/IP, NetBEUI, IPP *1 ), Windows 2000 (TCP/IP, NetBEUI, IPP *1 ), Win-
dows XP (TCP/IP, IPP *1 ), Windows NT 4.0 (TCP/IP, NetBEUI, IPP *1 ),
NetWare (IPX/SPX, TCP/IP) and Macintosh (AppleTalk) *2  protocols. This
allows you to use the machine in a network that uses different protocols
and operating systems.

• A computer used as a dedicated print server is not required because the
Network Interface Board can be configured as a NetWare print server.

• The Network Interface Board can connect the machine to the network
without requiring its own power supply because the Network Interface
Board is installed inside the machine.

*1 IPP (Internet Printing Protocol) is a protocol for printing via the Internet.
*2 Only Type80 RCP80 can be used on Macintosh.

NetWare (Server)

Windows NT (Server)
Windows 2000, Windows XP,

Windows 95/98/Me

Macintosh

Windows NT

         NetWare
          (Client)

Windows XP

Windows 2000

GSTN001
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Setting Up the Machine on a Network

Windows 95/98/Me

For setting up the machine as a network printer in a Windows 95/98/Me envi-
ronment, see p.1 “Windows 95/98/Me Configuration”. There are two methods
for using the machine as a network printer.



v

Windows 2000

For setting up the machine as a network printer in a Windows 2000 environ-
ment, see p.13 “Windows 2000 Configuration”. There are two methods for using
the machine as a network printer.
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Windows XP

For setting up the machine as a network printer in a Windows XP environment,
see p.25 “Windows XP Configuration”. There are two methods for using the ma-
chine as a network printer.
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Windows NT 4.0

For setting up the machine as a network printer in a Windows NT 4.0 environ-
ment, see p.37 “Windows NT 4.0 Configuration”. There are two methods for us-
ing the machine as a network printer.

NetWare

For setting up the machine as a network printer in a NetWare environment, see
p.51 “NetWare Configuration”. The Network Interface Board allows you to use
the machine as either a print server or a remote printer.

For more information about setting up the clients, see the following pages.

• When using Windows 95/98/Me, see p.70 “Windows 95/98/Me”.

• When using Windows 2000, Windows XP, see p.71 “Windows 2000/Win-
dows XP”.

• When using Windows NT 4.0, see p.72 “Windows NT 4.0”.
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Configuring the machine as a print server

A dedicated NetWare print server is not required because the machine can be
configured as a print server.

The actual procedures for configuring the machine depend on the NetWare version.

• When using NetWare 3.x, see p.57 “Setting Up as a Print Server”.

• When using NetWare 4.x, 5/5.1, see p.63 “Setting Up as a Print Server”.

Configuring the machine as a remote printer

If a dedicated NetWare print server is being used, the machine should be config-
ured as a remote printer.

The actual procedures for configuring the machine depend on the NetWare version.

• When using NetWare 3.x, see p.59 “Setting Up as a Remote Printer”.

• When using NetWare 4.x, 5/5.1, see p.67 “Setting Up as a Remote Printer”.
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Macintosh

For setting up the machine as a network printer in a Macintosh environment, see
p.73 “Macintosh Configuration”.

Note

❒ Only Type80 RCP80 can be used on Macintosh.
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1. Windows 95/98/Me
Configuration

Configuring Windows 95/98/Me

Printing without a Print Server

The following procedure describes how to configure Windows 95/98/Me to use
the machine on a network without a Windows 2000 Server, Windows 2000 Pro-
fessional, Windows XP, Windows NT Server, Windows NT Workstation or Net-
Ware based print server.

Printing with a Windows 2000/Windows XP or Windows NT Print 
Server

See p.10 “Setting Up a Client Computer” for configuring Windows 95/98/Me
with a Windows 2000/Windows XP or Windows NT print server.
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Configuring the Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 95/98/Me to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.

• Make sure that the TCP/IP protocol is set to active. (The default is active.)

• Assign an IP address and make other settings required for using the TCP/IP
protocol.

Reference

For more information about how to make the above settings, see Printer Ref-
erence 1.

If DHCP is used to assign IP addresses, see p.115 “When Using DHCP”.

Note

❒ After setting the IP address, use the ping command to make sure that it has
been set correctly.

A Enable the use of the command prompt as follows:

• On Windows 95 or Windows 98
Click [Start], point to [Programs], and then click [MS-DOS Prompt].

• On Windows Me
Click [Start], point to [Programs], point to [Accessories], and then click
[Command Prompt].

B Type the following: (192.168.15.16 is an example IP address.)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.
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Configuring a Windows 95/98/Me computer

These steps are for configuring a Windows 95/98/Me computer to use the
TCP/IP protocol.

AAAA Open the [Control Panel] and double-click the [Network] icon. Make sure that
“TCP/IP” is listed in the [The following network components are installed:] box on
the [Configuration] tab.

Note

❒ If the TCP/IP protocol is not installed, click the [Add] on the [Configuration]
tab to install it. For more information about installing the TCP/IP protocol,
see Windows 95/98/Me Help.

BBBB Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 95/98/Me to use the NetBEUI protocol.

Configuring the machine

Configure the machine to use the NetBEUI protocol.

• Make sure that the NetBEUI protocol is set to active. (The default is active.)

Note

❒ The NetBEUI settings are performed in Web Status Monitor or SmartDevice-
Monitor for Admin. See the corresponding online Help for details.
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Configuring a Windows 95/98/Me computer

Install the NetBEUI protocol on the Windows 95/98/Me computer and set it as
the default protocol.

AAAA Open the [Control Panel] and double-click the [Network] icon. Make sure that
“NetBEUI” is listed in the [The following network components are installed:] box
on the [Configuration] tab.

Note

❒ If the NetBEUI protocol is not installed, click [Add] on the [Configuration] tab
to install it. For more information about installing the NetBEUI protocol,
see Windows 95/98/Me Help.

❒ If the “NetBEUI →Dial-Up Adaptor” is listed in the [The following network
components are installed:] box, select it and click the [Remove] to remove the
binding.

BBBB Set the NetBEUI protocol as the default protocol. Click the [Configuration]
tab, select the “NetBEUI” in the [The following network components are installed:]
box, and click the [Properties].

CCCC Click the [Advanced] tab, select the [Set this protocol to be the default protocol],
and click the [OK].

DDDD Click the [OK] to close the [Network] dialog box.

EEEE Check the message to restart, and then click the [Yes].
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Using SmartDeviceMonitor for Client 

SmartDeviceMonitor for Client is a utility for printing with the network printer
using the TCP/IP, NetBEUI, and IPP protocols. The following features are avail-
able when using SmartDeviceMonitor for Client.

❖❖❖❖  SmartDeviceMonitor for Client features

• Sends a print job directly to the network printers without using a print
server.

• Notifies when a printing error occurs.

• That print did completion (data transmission is finished) is informed.

Note

❒ Make sure to close all applications before beginning the installation process.
Installing SmartDeviceMonitor for Client may require the computer to be re-
started.

Installing SmartDeviceMonitor for Client 

Follow the procedure below to install SmartDeviceMonitor for Client.

Note

❒ When there is a printing port used by PortNavi, Multi Direct Print and Print-
ing System95, SmartDeviceMonitor for Client will take over. 

❒ When using SmartDeviceMonitor for Admin, install SmartDeviceMonitor for
Client after SmartDeviceMonitor for Admin is closed.

❒ Make sure to close all applications before beginning the installation process.
Installing SmartDeviceMonitor for Client may require the computer to be re-
started.

AAAA Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

BBBB Open [Control Panel], and double-click the [Add/Remove Programs] icon.

CCCC On the [Install/Uninstall] tab, click [Install].

DDDD Click [Next >].

EEEE Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “:\ NETWORK \ NETMON \ CLIENT \ DISK1 \
SETUP.EXE” (do not include the quotation marks), and then click [Finish].

Note

❒ An example would be “D:\ NETWORK \ NETMON \ CLIENT \ DISK1
\ SETUP.EXE” when the CD-ROM drive letter is “D”.
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FFFF From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

GGGG After the [Welcome] dialog box appears, click [Next >].

Follow the instructions on the screen.

After the installation is complete, configure the printer port with SmartDe-
viceMonitor for Client. See p.7 “Setting Up the Printer Driver”

Note

❒ If the dialog box asking if you want to restart the computer appears, select
[Yes, I want to restart my computer now.].

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it.

Reference

For more information about SmartDeviceMonitor for Client, see SmartDe-
viceMonitor for Client Help.

AAAA From the [Printers] window, click the icon of the machine which uses Smart-
DeviceMonitor for Client to print. On the [File] menu, click [Properties].

BBBB Click the [Details] tab and make sure that the SmartDeviceMonitor for Cli-
ent port is shown in the [Print to the following port:] box.

Remember the port name because this port should be deleted later.

CCCC From the [Print to the following port:] box, select [FILE].

DDDD Click [OK].

EEEE Click [Delete Port].

FFFF Click the SmartDeviceMonitor for Client port name as in step BBBB, and then
click [OK]. 

The port is deleted.

GGGG Click [OK] to close the Printer Properties.
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Uninstalling SmartDeviceMonitor for Client 

Preparation

Before uninstalling SmartDeviceMonitor for Client, make sure that:

• The port settings dialog box is closed.

• No printer is using the SmartDeviceMonitor for Client port as a printer
port.

AAAA Open [Control Panel], and double-click the [Add/Remove Programs] icon.

BBBB On the [Install/Uninstall] tab, click [SmartDeviceMonitor for Client], and click
[Add/Remove].

CCCC After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartDeviceMonitor for
Client.

DDDD After the confirmation message appears, click [Yes].

EEEE Acknowledge the [Question] dialog box.

FFFF When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
DeviceMonitor for Client.

Preparation

The target machine must be turned on before starting the installation process.

AAAA Install the printer driver of the machine you want to use.

BBBB From the [Printers] window, click the icon of the machine. On the [File]
menu, click [Properties].

CCCC Click the [Details] tab, and then click [Add Port].

The [Add Port] dialog box appears.

DDDD Click [Other], click [SmartDeviceMonitor] from the list, and then click [OK].

The [Select Printer] dialog box appears.

The displayed items are as follows:

Model Name: The model name of the printer. 

Printer Name: The name of the printer.

Comment: Additional information about the printer.
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Address: The IP address of the printer.

EEEE Select the machine.

TCP/IP

A Click [TCP/IP], and then click [search].

A list of printers that can be printed to by the TCP/IP protocol appears.

B Click the machine you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

NetBEUI

A Click the [NetBEUI], and then click the [search].

A list of printers that can be printed to by the NetBEUI protocol appears.

B Click the machine you want to use, and then click the [OK].

Note

❒ Printers that respond to a broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address], and
then type the NetBEUI address. Make sure that the NetBEUI address is
on the system configuration list. For information about the printing of
the system configuration list, see Printer Reference 2.

❒ You cannot print to printers beyond routers.

IPP

A Click [IPP].

The IPP setting dialog box appears.

B To specify the IP address of the machine, type “http://machine's-ip-ad-
dress/printer” or “ipp://machine's-ip-address/printer“ in the [Printer URL]
field.

(192.168.15.16 is an example IP address)

http://192.168.15.16/printer

ipp://192.168.15.16/printer

C If necessary, type a names to distinguish printers in [IPP Port Name]. Type
a name different from any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.
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D If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Reference

For more information about these settings, see SmartDeviceMonitor for
Client Help.

FFFF Click [OK].

GGGG Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port:] box, and then click [OK].

This completes the settings.

To print, select the specified printer. SmartDeviceMonitor for Client will now
direct print data to the printer automatically.

Changing Port Settings

Follow these steps to change SmartDeviceMonitor for Client settings, such as
TCP/IP, the proxy server and IPP URL.

Note

❒ There are no settings for the NetBEUI protocol.

❒ You can configure Timeout Settings for the TCP/IP protocol.

AAAA From the [Printers] window, click the icon of the machine you want to use.
On the [File] menu, click [Properties].

BBBB Click the [Details] tab, and then click [Port Settings].

The [Port Settings] dialog box appears.

• For TCP/IP protocol, you can configure Timeout Settings.

• For IPP, you can configure User Settings or Proxy Settings.

Reference

For more information about these settings, see SmartDeviceMonitor for
Client Help.
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 Setting Up a Client Computer

This section describes the procedures for setting up a client on a network that
uses Windows 2000/Windows XP, Windows NT Server or Windows NT Work-
station as a print server.

When using a Windows 2000/Window XP or Windows NT print server, select
a shared printer on Windows 2000/Windows XP or Windows NT.

Note

❒ This section assumes that the client has already been configured to communi-
cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

AAAA Install the printer driver as a local printer.

Reference

For more information about installing the printer driver, see Printer Refer-
ence 1.

Note

❒ Any port can be selected during the installation, however, LPT1 is recom-
mended.

BBBB Click [Start], point to [Settings], and then click [Printers].

CCCC Click the icon of the machine you want to use. On the [File] menu, click
[Properties].

DDDD Click the [Details] tab, and click [Add Port].

EEEE Click [Network], and click [Browse].
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FFFF On the network tree, double-click the name of the computer used as a print
server.

The printers connected to the network are displayed.

GGGG Click the name of the machine you want to use, and click [OK].

HHHH Click [OK].

IIII Make sure that the port name is displayed in the [Print to the following port:]
box, and click [OK].
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2. Windows 2000
Configuration

Configuring Windows 2000

Printing without a Print Server

The following procedure describes how to configure Windows 2000 to use the
machine on a network without a Windows 2000 Server, Windows 2000 Profes-
sional, Window XP, Windows NT Server, Windows NT Workstation or Net-
Ware based print server.
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Printing with a Standard TCP/IP Port

Standard TCP/IP port is a standard port of Windows 2000 to enable Peer-to-
Peer printing in a network environment.

For more information about Standard TCP/IP port settings, see Windows 2000
Help.

Note

❒ If a device model selection dialog box appears during the procedure to add
the Standard TCP/IP port, select “RICOH Network Printer C Model”.

Printing with a LPR Port

See p.22 “Configuring LPR Port Printing” for configuring a LPR port in Win-
dows 2000.

Printing with a Windows 2000 or Windows NT Print Server

See p.23 “Setting Up a Client Computer” for configuring Windows 2000 with a
Windows 2000/Windows XP or Windows NT print server.
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Configuring the Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 2000 to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.

• Make sure that the TCP/IP protocol is set to active. (The default is active.)

• Assign an IP address and make other settings required for using the TCP/IP
protocol.

Reference

For more information about how to make the above settings, see Printer Ref-
erence 1.

If DHCP is used to assign IP addresses, see p.115 “When Using DHCP”.

Note

❒ After setting the IP address, use the ping command to make sure that it has
been set correctly.

A Click [Start], point to [Programs], point to [Accessories], and then click [Com-
mand Prompt].

B Type the following: (192.168.15.16 is an example IP address.)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.

Configuring a Windows 2000 computer

These steps are for configuring a Windows 2000 computer to use the TCP/IP
protocol.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

BBBB Double-click [Local Area Connection]. On the [General] tab, click [Properties].
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CCCC Make sure that “Internet Protocol (TCP/IP)” is selected in the [Components
checked are used by this connection:] box on the [General] tab.

Note

❒ Select the TCP/IP protocol box if it is not already selected.

❒ If the TCP/IP protocol is not installed, click [Install] on the [General] tab to
install it. For more information about installing the TCP/IP protocol, see
Windows 2000 Help.

DDDD Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 2000 to use the NetBEUI protocol.

Configuring the machine

Configure the machine to use the NetBEUI protocol.

• Make sure that the NetBEUI protocol is set to active. (The default is active.)

Note

❒ The NetBEUI settings are performed in Web Status Monitor or SmartDevice-
Monitor for Admin. See the corresponding online Help for details.

Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the NetBEUI
protocol.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

BBBB Double-click [Local Area Connection]. On the [General] tab, click [Properties].

CCCC Make sure that the “NetBEUI Protocol” is selected in the [Components
checked are used by this connection:] box on the [General] tab.

Note

❒ Select the NetBEUI protocol box if it is not already selected.

❒ If the NetBEUI protocol is not installed, click [Install] on the [General] tab to
install it. For more information about installing the NetBEUI protocol, see
Windows 2000 Help.
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Using SmartDeviceMonitor for Client 

SmartDeviceMonitor for Client is a utility for printing with the network printer
using the TCP/IP, NetBEUI, and IPP protocols. The following features are avail-
able when using SmartDeviceMonitor for Client.

❖❖❖❖  SmartDeviceMonitor for Client features

• Sends a print job directly to the network printers without using a print
server.

• Notifies when a printing error occurs.

• That print did completion (data transmission is finished) is informed.

Limitation

❒ On a computer that is used as a print server, do not use the features such as
Notify. For more information about turning off these features, see SmartDe-
viceMonitor for Client Help.

Note

❒ Make sure to close all applications before beginning the installation process.
Installing SmartDeviceMonitor for Client may require the computer to be re-
started.

Installing SmartDeviceMonitor for Client 

Follow the procedure below to install SmartDeviceMonitor for Client.

Note

❒ When there is a printing port used by PortNavi, Multi Direct Print and Print-
ing System95, SmartDeviceMonitor for Client will take over. 

❒ When using SmartDeviceMonitor for Admin, install SmartDeviceMonitor for
Client after SmartDeviceMonitor for Admin is closed.

❒ Make sure to close all applications before beginning the installation process.
Installing SmartDeviceMonitor for Client may require the computer to be re-
started.

AAAA Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

BBBB Open [Control Panel], and double-click the [Add/Remove Programs] icon.

CCCC On the [Add New Programs] tab, click [CD or Floppy].

DDDD Click [Next >].
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EEEE Type the name of the CD-ROM drive in the [Open] box, followed by “:\
NETWORK \ NETMON \ CLIENT \ DISK1 \ SETUP.EXE” (do not in-
clude the quotation marks), and then click [Finish].

Note

❒ An example would be “D:\ NETWORK \ NETMON \ CLIENT \ DISK1
\ SETUP.EXE” when the CD-ROM drive letter is “D”.

FFFF From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

GGGG After the [Welcome] dialog box appears, click [Next >].

Follow the instructions on the screen.

After the installation is complete, configure the printer port with SmartDe-
viceMonitor for Client. See p.19 “Setting Up the Printer Driver”

Note

❒ If the dialog box asking if you want to restart the computer appears, select
[Yes, I want to restart my computer now.].

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it.

Reference

For more information about SmartDeviceMonitor for Client, see SmartDe-
viceMonitor for Client Help.

AAAA From the [Printers] window, click the icon of the machine which uses Smart-
DeviceMonitor for Client to print. On the [File] menu, click [Properties].

BBBB Click the [Ports] tab and make sure that the SmartDeviceMonitor for Client
port is shown in the [Print to the following port(s)] box.

Remember the port name because this port should be deleted later.

CCCC Select the [FILE] check box in the [Port] column.

DDDD Click [OK] to close the Printer Properties.

The port which is currently in use is changed.

EEEE Open the Printer Properties of the same machine.

FFFF Select the [Ports] tab.

GGGG At the [Port] column in the [Print to the following port(s)] dialog box, click to se-
lect the SmartDeviceMonitor for Client port name as in step BBBB. 
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HHHH Click [Delete Port].

IIII After the confirmation message appears, click [Yes].

The port is deleted.

JJJJ Click [Close] to close the Printer Properties.

Uninstalling SmartDeviceMonitor for Client 

Preparation

Before uninstalling SmartDeviceMonitor for Client, make sure that:

• The port settings dialog box is closed.

• No printer is using the SmartDeviceMonitor for Client port as a printer
port.

• You have performed login with the same user authority as that used to in-
stall SmartDeviceMonitor for Client.

AAAA Open [Control Panel], and double-click the [Add/Remove Programs] icon.

BBBB Click the [Change or Remove Programs] tab, click [SmartDeviceMonitor for Client],
and click [Change/Remove].

CCCC After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartDeviceMonitor for
Client.

DDDD After the confirmation message appears, click [Yes].

EEEE Acknowledge the [Remove Shared File?] dialog box.

FFFF When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
DeviceMonitor for Client.

Preparation

The target machine must be turned on before starting the installation process.

AAAA Install the printer driver of the machine you want to use.

BBBB From the [Printers] window, click the icon of the machine. On the [File]
menu, click [Properties].

CCCC Click the [Ports] tab, and then click [Add Port].

The [Add Port] dialog box appears.
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DDDD Click [SmartDeviceMonitor] in the [Available port types:] box, and then click [New Port].

The [Select Printer] dialog box appears. 

The displayed items are as follows: 

Model Name: The model name of the printer.

Printer Name: The name of the printer.

Comment: Additional information about the printer.

Address: The IP address of the printer.

EEEE Select the machine.

TCP/IP

A Click [TCP/IP], and then click [search].

A list of printers that can be printed to by the TCP/IP protocol appears.

B Click the machine you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] , and
then type the IP address or host name.

NetBEUI

A Click [NetBEUI], and then [search].

A list of printers that can be printed by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to a broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address], and
then type the NetBEUI address. Make sure that the NetBEUI address is
on the system configuration list. For information about the printing of
the system configuration list, see Printer Reference 2.

❒ You cannot print to printers beyond routers.

IPP

A Click [IPP].

The IPP setting dialog box appears.

B To specify the IP address of the machine, type “http://machine's-ip-ad-
dress/printer" or "ipp://machine's-ip-address/printer" in the [Printer URL] field.

(192.168.15.16 is an example IP address.)

http://192.168.15.16/printer

ipp://192.168.15.16/printer
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C If necessary, type a name to distinguish printers in [IPP Port Name]. Type
a name different from any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

D If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Reference

For more information about these settings, see SmartDeviceMonitor for
Client Help.

E Click [OK].

FFFF Click [OK].

GGGG Click [Close].

HHHH Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and then click [OK].

This completes the settings.

To print, select the specified printer. SmartDeviceMonitor for Client will now
direct print data to the printer automatically.

Changing Port Settings

Follow these steps to change SmartDeviceMonitor for Client settings, such as
TCP/IP, the proxy server and IPP URL.

Note

❒ There are no settings for the NetBEUI protocol.

AAAA From the [Printers] window, click the icon of the machine you want to use.
On the [File] menu, click [Properties].

BBBB Click the [Ports] tab, and then click [Configure Port].

The [Port Configuration] dialog box appears.

• For TCP/IP protocol, you can configure Timeout Settings.

• For IPP, you can configure User Settings or Proxy Settings.

Reference

For more information about these settings, see SmartDeviceMonitor for
Client Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
2000.

Note

❒ The following procedure assumes that the printer drivers have already been
installed. This is the procedure to change the printer port to LPR.

❒ The TCP/IP protocols must be installed and configured correctly. For more
information about configuring the protocols, see p.15 “Configuring TCP/IP
and IPP for Printing”.

AAAA Click [Start], point to [Settings], and then click [Printers].

BBBB Click the icon of the machine you want to use. On the [File] menu, click
[Properties].

CCCC Click the [Ports] tab, and then click [Add Port].

DDDD In the [Available port types:] box, click “LPR Port”, and then click [New Port].

Note

❒ If “LPR Port” does not appear, “Print Services for Unix” has not been in-
stalled.

EEEE Type the IP address of the Network Interface Board into the [Name or address
of server providing lpd:] box.

FFFF Type “lp” into the [Name of printer or print queue on that server:] box, and click
[OK].

GGGG Click [Close].

HHHH Make sure that the port name is displayed in the [Print to the following port(s)]
box and the check box is selected, and then click [OK].
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Setting Up a Client Computer

This section describes the procedures for setting up a client on a network that
uses Windows 2000/Windows XP, Windows NT Server or Windows NT Work-
station as a print server.

When using a Windows 2000/Windows XP, Windows NT print server, select a
shared printer on Windows 2000/Windows XP or Windows NT.

Note

❒ This section assumes that the client has already been configured to communi-
cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

Use the [Printers] window to set up the machine.

AAAA Click [Start], point to [Settings], and then click [Printers].

BBBB Double-click the [Add Printer] icon.

This launches the Add Printer Wizard.

CCCC Click [Next >].

DDDD Click [Network printer], and click [Next >].

EEEE Click [Next >].

FFFF In the [Shared printers:] box, double-click the name of the computer used as
a print server.

The printers attached to the network are displayed.

W2kNTP001E
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GGGG Click the machine you want to use, and click [Next >].

Note

❒ If the printer driver is not installed in the print server, a message appears.
If a driver has been installed on the client, click [OK], and follow the in-
structions on the screen.

❒ There is a Windows 2000 printer driver on the CD-ROM labeled “Printer
Drivers and Utilities”.

HHHH Select whether to use this machine as the default printer, and click [Next >].

IIII After the installation is complete, click [Finish].

The icon of the newly installed printer appears in the [Printers] window.
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3. Windows XP Configuration

Configuring Windows XP

Printing without a Print Server

The following procedure describes how to configure Windows XP to use the ma-
chine on a network without a Windows 2000 Server, Windows 2000 Profession-
al, Window XP, Windows NT Server, Windows NT Workstation or NetWare
based print server.
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Printing with a Standard TCP/IP Port

Standard TCP/IP port is a standard port of Windows XP to enable Peer-to-Peer
printing in a network environment.

For more information about Standard TCP/IP port settings, see Windows 2000
Help.

Note

❒ If a device model selection dialog box appears during the procedure to add
the Standard TCP/IP port, select “RICOH Network Printer C Model”.

Printing with a LPR Port

See p.34 “Configuring LPR Port Printing” for configuring a LPR port in Win-
dows XP.

Printing with a Windows 2000/Windows XP or Windows NT Print 
Server

See p.35 “Setting Up a Client Computer” for configuring Windows XP with a
Windows 2000/Windows XP or Windows NT print server.
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Configuring the Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows XP to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.

• Make sure that the TCP/IP protocol is set to active. (The default is active.)

• Assign an IP address and make other settings required for using the TCP/IP
protocol.

Reference

For more information about how to make the above settings, see Printer Ref-
erence 1.

If DHCP is used to assign IP addresses, see p.115 “When Using DHCP”.

Note

❒ After setting the IP address, use the ping command to make sure that it has
been set correctly.

A Click [Start], point to [Programs], point to [Accessories], and then click [Com-
mand Prompt].

B Type the following: (192.168.15.16 is an example IP address.)
C:\>ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.
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Configuring a Windows XP computer

These steps are for configuring a Windows XP computer to use the TCP/IP pro-
tocol.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

BBBB Double-click [Local Area Connection]. On the [General] tab, click [Properties].

CCCC Make sure that “Internet Protocol (TCP/IP)” is selected in the [Components
checked are used by this connection:] box on the [General] tab.

Note

❒ Select the TCP/IP protocol box if it is not already selected.

❒ If the TCP/IP protocol is not installed, click [Install] on the [General] tab to
install it. For more information about installing the TCP/IP protocol, see
Windows XP Help.

DDDD Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.
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Using SmartDeviceMonitor for Client 

SmartDeviceMonitor for Client is a utility for printing with the network printer
using the TCP/IP, and IPP protocols. The following features are available when
using SmartDeviceMonitor for Client.

❖❖❖❖  SmartDeviceMonitor for Client features

• Sends a print job directly to the network printers without using a print
server.

• Notifies when a printing error occurs.

• That print did completion (data transmission is finished) is informed.

Limitation

❒ On a computer that is used as a print server, do not use the features such as
Notify. For more information about turning off these features, see SmartDe-
viceMonitor for Client Help.

Note

❒ Make sure to close all applications before beginning the installation process.
Installing SmartDeviceMonitor for Client may require the computer to be re-
started.

Installing SmartDeviceMonitor for Client 

Follow the procedure below to install SmartDeviceMonitor for Client.

Note

❒ When there is a printing port used by PortNavi, Multi Direct Print and Print-
ing System95, SmartDeviceMonitor for Client will take over. 

❒ When using SmartDeviceMonitor for Admin, install SmartDeviceMonitor for
Client after SmartDeviceMonitor for Admin is closed.

❒ Make sure to close all applications before beginning the installation process.
Installing SmartDeviceMonitor for Client may require the computer to be re-
started.

AAAA Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

BBBB Open [Control Panel], and double-click the [Add/Remove Programs] icon.

CCCC On the [Add New Programs] tab, click [CD or Floppy].

DDDD Click [Next >].
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EEEE Type the name of the CD-ROM drive in the [Open] box, followed by “:\
NETWORK\NETMON\CLIENT\DISK1\SETUP.EXE” (do not include
the quotation marks), and then click [Finish].

Note

❒ An example would be “D:\ NETWORK\NETMON\CLIENT\DISK1\SET-
UP.EXE” when the CD-ROM drive letter is “D”.

FFFF From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

GGGG After the [Welcome] dialog box appears, click [Next >].

Follow the instructions on the screen.

After the installation is complete, configure the printer port with SmartDe-
viceMonitor for Client. See p.32 “Setting Up the Printer Driver”.

Note

❒ If the dialog box asking if you want to restart the computer appears, select
[Yes, I want to restart my computer now.].

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it.

Reference

For more information about SmartDeviceMonitor for Client, see SmartDe-
viceMonitor for Client Help.

AAAA From the [Printers] window, click the icon of the machine which uses Smart-
DeviceMonitor for Client to print. On the [File] menu, click [Properties].

BBBB Click the [Ports] tab and make sure that the SmartDeviceMonitor for Client
port is shown in the [Print to the following port(s)] box.

Remember the port name because this port should be deleted later.

CCCC Select the [FILE] check box in the [Port] column.

DDDD Click [OK] to close the Printer Properties.

The port which is currently in use is changed.

EEEE Open the Printer Properties of the same machine.

FFFF Select the [Ports] tab.

GGGG At the [Port] column in the [Print to the following port(s)] dialog box, click to se-
lect the SmartDeviceMonitor for Client port name as in step BBBB. 
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HHHH Click [Delete Port].

IIII After the confirmation message appears, click [Yes].

The port is deleted.

JJJJ Click [Close] to close the Printer Properties.

Uninstalling SmartDeviceMonitor for Client 

Preparation

Before uninstalling SmartDeviceMonitor for Client, make sure that:

• The port settings dialog box is closed.

• No printer is using the SmartDeviceMonitor for Client port as a printer
port.

• You have performed login with the same user authority as that used to in-
stall SmartDeviceMonitor for Client.

AAAA Open [Control Panel], and double-click the [Add/Remove Programs] icon.

BBBB Click the [Change or Remove Programs] tab, click [SmartDeviceMonitor for Client],
and click [Change/Remove].

CCCC After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartDeviceMonitor for
Client.

DDDD After the confirmation message appears, click [Yes].

EEEE Acknowledge the [Remove Shared File?] dialog box.

FFFF When the uninstallation is complete, click [OK].
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Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
DeviceMonitor for Client.

Preparation

The target machine must be turned on before starting the installation process.

AAAA Install the printer driver of the machine you want to use.

BBBB From the [Printers] window, click the icon of the machine. On the [File]
menu, click [Properties].

CCCC Click the [Ports] tab, and then click [Add Port].

The [Add Port] dialog box appears.

DDDD Click [SmartDeviceMonitor] in the [Available port types:] box, and then click [New
Port].

The [Select Printer] dialog box appears. 

The displayed items are as follows: 

Model Name: The model name of the printer.

Printer Name: The name of the printer.

Comment: Additional information about the printer.

Address: The IP address of the printer.

EEEE Select the machine.

TCP/IP

A Click [TCP/IP], and then click [search].

A list of printers that can be printed to by the TCP/IP protocol appears.

B Click the machine you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

IPP

A Click [IPP].

The IPP setting dialog box appears.
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B To specify the IP address of the machine, type "http://machine's-ip-ad-
dress/printer" or "ipp://machine's-ip-address/printer" in the [Printer URL]
field.

(192.168.15.16 is an example IP address.)

http://192.168.15.16/printer

ipp://192.168.15.16/printer

C If necessary, type a name to distinguish the printers in [IPP Port Name].
Type a name different from any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

D If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Reference

For more information about these settings, see SmartDeviceMonitor for
Client Help.

E Click [OK].

FFFF Click [OK].

GGGG Click [Close].

HHHH Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and then click [OK].

This completes the settings.

To print, select the specified printer. SmartDeviceMonitor for Client will now
direct print data to the printer automatically.

Changing Port Settings

Follow these steps to change SmartDeviceMonitor for Client settings, such as
TCP/IP, the proxy server and IPP URL.

AAAA From the [Printers] window, click the icon of the machine you want to use.
On the [File] menu, click [Properties].

BBBB Click the [Ports] tab, and then click [Configure Port].

The [Port Configuration] dialog box appears.

• For TCP/IP protocol, you can configure Timeout Settings.

• For IPP, you can configure User Settings or Proxy Settings.

Reference

For more information about these settings, see SmartDeviceMonitor for
Client Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
XP.

Note

❒ The following procedure assumes that the printer drivers have already been
installed. This is the procedure to change the printer port to LPR.

❒ The TCP/IP protocols must be installed and configured correctly. For more
information about configuring the protocols, see p.27 “Configuring TCP/IP
and IPP for Printing”.

AAAA Click [Start], point to [Settings], and then click [Printers].

BBBB Click the icon of the machine you want to use. On the [File] menu, click
[Properties].

CCCC Click the [Ports] tab, and then click [Add Port].

DDDD In the [Available port types:] box, click “LPR Port”, and then click [New Port].

Note

❒ If “LPR Port” does not appear, “Print Services for Unix” has not been in-
stalled.

EEEE Type the IP address of the Network Interface Board into the [Name or address
of server providing lpd:] box.

FFFF Type “lp” into the [Name of printer or print queue on that server:] box, and click
[OK].

GGGG Click [Close].

HHHH Make sure that the port name is displayed in the [Print to the following port(s)]
box and the check box is selected, and then click [OK].
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Setting Up a Client Computer

This section describes the procedures for setting up a client on a network that
uses Windows 2000/Windows XP, Windows NT Server or Windows NT Work-
station as a print server.

When using a Windows 2000/Windows XP, Windows NT print server, select a
shared printer on Windows 2000/Windows XP or Windows NT.

Note

❒ This section assumes that the client has already been configured to communi-
cate with a Windows 2000/Windows XP or Windows NT print server. Do not
begin the following procedure until the client has been set up and configured
correctly.

Use the [Printers] window to set up the machine.

AAAA Click [Start], point to [Settings], and then click [Printers].

BBBB Double-click the [Add Printer] icon.

This launches the Add Printer Wizard.

CCCC Click [Next >].

DDDD Click [Network printer], and click [Next >].

EEEE Click [Next >].

FFFF In the [Shared printers:] box, double-click the name of the computer used as
a print server.

The printers attached to the network are displayed.

W2kNTP001E
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GGGG Click the machine you want to use, and click [Next >].

Note

❒ If the printer driver is not installed in the print server, a message appears.
If a driver has been installed on the client, click [OK], and follow the in-
structions on the screen.

❒ There is a Windows XP printer driver on the CD-ROM labeled “Printer
Drivers and Utilities”.

HHHH Select whether to use this machine as the default printer, and click [Next >].

IIII After the installation is complete, click [Finish].

The icon of the newly installed printer appears in the [Printers] window.



37

4. Windows NT 4.0
Configuration

Configuring Windows NT 4.0

Printing without a Print Server

The following procedure describes how to configure Windows NT 4.0 to use the
machine on a network without a Windows 2000 Server, Windows 2000 Profes-
sional, Windows XP, Windows NT Server, Windows NT Workstation or Net-
Ware based print server.
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Printing with a LPR Port

See p.47 “Configuring LPR Port Printing” for configuring a LPR port in Win-
dows NT 4.0.

Printing with a Windows 2000/Windows XP or Windows NT Print 
Server

See p.48 “Setting Up a Client Computer” for configuring Windows NT 4.0 with
a Windows 2000/Windows XP or Windows NT print server.
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Configuring the Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows NT to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.

• Make sure that the TCP/IP protocol is set to active. (The default is active.)

• Assign an IP address and make other settings required for using the TCP/IP
protocol.

Reference

For more information about how to make the above settings, see Printer Ref-
erence 1.

If DHCP is used to assign IP addresses, see p.115 “When Using DHCP”.

Note

❒ After setting the IP address, use the ping command to make sure that it has
been set correctly.

A Click [Start], point to [Programs], and then click [Command Prompt].

B Type the following: (192.168.15.16 is an example IP address.)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.
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Configuring a Windows NT computer

These steps are for configuring a Windows NT computer to use the TCP/IP pro-
tocol.

AAAA Open [Control Panel] and double-click the [Network] icon. Make sure that
“TCP/IP Protocol” is listed in the [Network Protocols:] box on the [Protocols]
tab.

Note

❒ If the TCP/IP protocol is not installed, click [Add] on the [Protocols] tab to
install it. For more information about installing the TCP/IP protocol, see
Windows NT Help.

BBBB Configure the TCP/IP protocols with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

CCCC Click the [Services] tab, and make sure that “Microsoft TCP/IP Printing” is
installed.

If “Microsoft TCP/IP Printing” is not installed, click [Add] on the [Services] tab
to install it. For more information about installing and configuring network
services, see Windows NT Help.

Configuring NetBEUI for Printing

These instructions are for configuring the Network Interface Board and Win-
dows NT to use the NetBEUI protocol.

Configuring the machine

Configure the machine to use the NetBEUI protocol.

• Make sure that the NetBEUI protocol is set to active. (The default is active.)

Note

❒ The NetBEUI settings are performed in Web Status Monitor or SmartDevice-
Monitor for Admin. See the corresponding online Help for details.
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Configuring a Windows NT computer

Install the NetBEUI protocol on the Windows NT computer, and change the
LAN adapter number (Lana Number).

AAAA Open [Control Panel] and double-click the [Network] icon. Make sure that
“NetBEUI Protocol” is listed in the [Network Protocols:] box on the [Protocols]
tab.

Note

❒ If the NetBEUI protocol is not installed, click [Add] on the [Protocols] tab to
install it. For more information about installing the NetBEUI protocol, see
Windows NT Help.

BBBB Change the Lana Number. Click the [Services] tab, click “NetBIOS Inter-
face” in the [Services] tab, and click [Properties].

CCCC Click the Lana Number corresponding the Nbf protocol of the [Network
Route] headline, and click [Edit].

DDDD Type “0” as the Lana Number.

Note

❒ If the other protocol's Lana Number is configured with “0”, you must
change the Lana Number to a number other than “0”.

EEEE Click [OK].

FFFF Click [Close] to close the [Network] dialog box.

GGGG Check the message to restart, and then click [Yes].

Note

❒ After you change the Lana Number, you must restart the computer.
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Using SmartDeviceMonitor for Client 

SmartDeviceMonitor for Client is a utility for printing with the network printer
using the TCP/IP, NetBEUI, and IPP protocols. The following features are avail-
able when using SmartDeviceMonitor for Client.

❖❖❖❖  SmartDeviceMonitor for Client features

• Sends a print job directly to the network printers without using a print
server.

• Notifies when a printing error occurs.

• That print did completion (data transmission is finished) is informed.

Limitation

❒ On a computer that is used as a print server, do not use the features such as
Notify. For more information about turning off these features, see SmartDe-
viceMonitor for Client Help.

Note

❒ Make sure to close all applications before beginning the installation process.
Installing SmartDeviceMonitor for Client may require the computer to be re-
started.

Installing SmartDeviceMonitor for Client 

Follow the procedure below to install SmartDeviceMonitor for Client.

Note

❒ When there is a printing port used by PortNavi, Multi Direct Print and Print-
ing System95, SmartDeviceMonitor for Client will take over.

❒ When using SmartDeviceMonitor for Admin, install SmartDeviceMonitor for
Client after SmartDeviceMonitor for Admin is closed.

❒ Make sure to close all applications before beginning the installation process.
Installing SmartDeviceMonitor for Client may require the computer to be re-
started.

AAAA Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

BBBB Open [Control Panel], and double-click the [Add/Remove Programs] icon.

CCCC On the [Install/Uninstall] tab, click [Install].

DDDD Click [Next >].
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EEEE Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “:\ NETWORK\NETMON\CLIENT\DISK1\SET-
UP.EXE” (do not include the quotation marks), and then click [Finish].

Note

❒ An example would be “D:\ NETWORK \ NETMON \ CLIENT \ DISK1
\ SETUP.EXE” when the CD-ROM drive letter is “D”.

FFFF From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

GGGG After the [Welcome] dialog box appears, click [Next >].

Follow the instructions on the screen.

After the installation is complete, configure the printer port with SmartDe-
viceMonitor for Client. See p.44 “Setting Up the Printer Driver”.

Note

❒ If the dialog box asking if you want to restart the computer appears, select
[Yes, I want to restart my computer now.].

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it.

Reference

For more information about SmartDeviceMonitor for Client, see SmartDe-
viceMonitor for Client Help.

AAAA From the [Printers] window, click the icon of the machine which uses Smart-
DeviceMonitor for Client to print. On the [File] menu, click [Properties].

BBBB Click the [Ports] tab and make sure that the SmartDeviceMonitor for Client
port is shown in the [Print to the following port(s)] box.

Remember the port name because this port should be deleted later.

CCCC From the [Print to the following port(s)] box, select [FILE].

DDDD Click [OK].

The port which is currently in use is changed.

EEEE Click [Delete Port].

FFFF After the confirmation message appears, click [Yes].

The port is deleted.

GGGG Click [OK] to close the Printer Properties.
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Uninstalling SmartDeviceMonitor for Client 

Preparation

Before uninstalling SmartDeviceMonitor for Client, make sure that:

• The port settings dialog box is closed.

• No printer is using the SmartDeviceMonitor for Client port as a printer port.

• You have performed login with the same user authority as that used to in-
stall SmartDeviceMonitor for Client.

AAAA Open [Control Panel], and double-click the [Add/Remove Programs] icon.

BBBB On the [Install/Uninstall] tab, click [SmartDeviceMonitor for Client], and click [Add/Re-
move].

CCCC After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartDeviceMonitor for Client.

DDDD After the confirmation message appears, click [Yes].

EEEE Acknowledge the [Remove Shared File?] dialog box.

FFFF When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
DeviceMonitor for Client.

Preparation

The target machine must be turned on before starting the installation process.

AAAA Install the printer driver of the machine you want to use.

BBBB From the [Printers] window, click the icon of the machine. On the [File]
menu, click [Properties].

CCCC Click the [Ports] tab, and then click [Add Port].

The [Add Port] dialog box appears.

DDDD Click [SmartDeviceMonitor] from the list, and then click [New Port...].

The [Select Printer] dialog box appears and printers. 

The displayed items are as follows:

Model Name: The model name of the printer. 

Printer Name: The name of the printer.

Comment: Additional information about the printer.

Address: The IP address of the printer.
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EEEE Select the machine.

TCP/IP

A Click [TCP/IP], and then click [search].

A list of printers that can be printed to by the TCP/IP protocol appears.

B Click the machine you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

NetBEUI

A Click [NetBEUI], and then click [search].

A list of printers that can be printed by the NetBEUI protocol appears.

B Click the machine you want to use, and then click [OK].

Note

❒ Printers that respond to a broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address], and
then type the NetBEUI address. Make sure that the NetBEUI address is
on the system configuration list. For information about the printing of
the system configuration list, see Printer Reference 2.

❒ You cannot print to printers beyond routers.

IPP

A Click [IPP].

The IPP setting dialog box appears.

B To specify the IP address of the machine, type "http://machine's-ip-ad-
dress/printer" or "ipp://machine's-ip-address/printer" in the [Printer URL]
field.

(192.168.15.16 is an example IP address.)

http://192.168.15.16/printer

ipp://192.168.15.16/printer

C If necessary, type a name to distinguish printers in [IPP Port Name]. Type
a name different from any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.
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D If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Reference

For more information about these settings, see SmartDeviceMonitor for
Client Help.

E Click [OK].

FFFF Click [OK].

GGGG Click [Close].

HHHH Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and then click [OK].

This completes the settings.

To print, select the printer specified. SmartDeviceMonitor for Client will now
direct print data to the printer automatically.

Changing Port Settings

Follow these steps to change SmartDeviceMonitor for Client settings, such as
TCP/IP, the proxy server and IPP URL.

Note

❒ There are no settings for the NetBEUI protocol.

AAAA From the [Printers] window, click the icon of the machine you want to use.
On the [File] menu, click [Properties].

BBBB Click the [Ports] tab, and then click [Configure Port].

The [Port Configuration] dialog box appears.

• For TCP/IP protocol, you can configure Timeout Settings.

• For IPP, you can configure User Settings or Proxy Settings.

Reference

For more information about these settings, see SmartDeviceMonitor for
Client Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
NT.

Note

❒ The following procedure assumes that the printer drivers have already been
installed. This is the procedure to change the printer port to LPR.

❒ The TCP/IP protocols must be installed and configured correctly. For more
information about configuring the protocols, see p.39 “Configuring TCP/IP
and IPP for Printing”.

AAAA Click [Start], point to [Settings], and then click [Printers].

BBBB Click the icon of the machine you want to use. On the [File] menu, click
[Properties].

CCCC Click the [Ports] tab, and then click [Add Port].

DDDD In the [Available Printer Ports:] box, click “LPR Port”, and then click [New Port].

Note

❒ If “LPR Port” does not appear, “Microsoft TCP/IP Printing” has not been
installed.

EEEE Type the IP address of the Network Interface Board into the [Name or address
of server providing lpd:] box.

FFFF Type “lp” into the [Name of printer or print queue on that server:] box, and click
[OK].

GGGG Click [Close].

HHHH Make sure that the port name is displayed in the [Print to the following port(s)]
box and the check box is selected, and then click [OK].
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Setting Up a Client Computer

This section describes the procedures for setting up a client on a network that
uses Windows 2000/Windows XP, Windows NT Server or Windows NT Work-
station as a print server.

When using a Windows 2000/Windows XP or Windows NT print server, select
a shared printer on Windows 2000 or Windows NT.

Note

❒ This section assumes that the client has already been configured to communi-
cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

Use the [Printers] window to set up the machine.

AAAA Click [Start], point to [Settings], and then click [Printers].

BBBB Double-click the [Add Printer] icon.

This launches the Add Printer Wizard.

CCCC Click [Network printer server] and click [Next >].

DDDD In the [Shared Printers:] box, double-click the name of the computer used as
a print server.

The printers attached to the network are displayed.
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EEEE Click the machine you want to use and click [OK].

Note

❒ If the printer driver is not installed in the print server, a message appears.
If a driver has been installed on the client, click [OK], and follow the in-
structions on the screen.

❒ There is a Windows NT printer driver on the CD-ROM labeled “Printer
Drivers and Utilities”.

FFFF Select whether to use this machine as the default printer, and click [Next >].

GGGG After the installation is complete, click [Finish].

The icon of the newly installed printer appears in the [Printers] window.
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5. NetWare Configuration

This chapter describes how to configure the machine to use as a print server or
a remote printer in a NetWare environment.

Note

❒ The NetWare settings are performed in Web Status Monitor or SmartDevice-
Monitor for Admin. See the corresponding online Help for details.

Installing the NIB Setup Tool 

A utility called the NIB Setup Tool is provided to configure the machine to work
in a network environment. This section describes how to install the SmartDe-
viceMonitor for Admin, and how to run the NIB Setup Tool.

Limitation

❒ The NIB Setup Tool is supported to work with the following operating sys-
tems.

• Microsoft Windows 95/98/Me

• Microsoft Windows 2000/Microsoft Windows XP

• Microsoft Windows NT 4.0

Installing SmartDeviceMonitor for Admin 

Follow these steps to install the SmartDeviceMonitor for Admin.

Preparation

You should install the SmartDeviceMonitor for Admin on the computer. If
you install the SmartDeviceMonitor for Admin from a file server or run it via
the network, the SmartDeviceMonitor for Admin might not work correctly.

Make sure to close all applications before starting the installation procedure.

AAAA Close all the applications that are currently running.

BBBB Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

CCCC Open [Control Panel], and double-click the [Add/Remove Programs] icon.

DDDD On the [Install/Uninstall] tab, click [Install].

EEEE Click [Next >].
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FFFF In the [Command line for installation program] box, type the name of the CD-
ROM drive followed by “:\NETWORK\NETMON\ADMIN\DISK1\SET-
UP.EXE” (do not include the quotation marks), and then click [Finish].

Note

❒ An example would be “D:\NETWORK\NETMON\ADMIN\DISK1\SET-
UP.EXE” when the CD-ROM drive name is “D”.

GGGG From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

HHHH After the [Welcome] dialog box appears, click [Next >].

Follow the instructions on the screen.

Running the NIB Setup Tool 

AAAA Click [Start], point to [Programs], and then click [NIB Setup Tool] in the [Smart-
DeviceMonitor for Admin] program folder.
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Quick Setup Using the NIB Setup Tool 
Wizard

With the NIB Setup Tool, you can easily set up a NetWare printing environment. 

Reference

For more information about installing the NIB Setup Tool, see p.51 “Installing
the NIB Setup Tool”.

You can select [Wizard] or [Property Sheet] as an installation method.

When you configure the Network Interface Board for the first time, use the Wiz-
ard method.

If you want to use the Property Sheet method, see p.56 “NetWare 3.x - Advanced
Settings” or p.62 “NetWare 4.x, 5/5.1 - Advanced Settings”.

Note

❒ This section assumes that NetWare is functional and that the necessary envi-
ronment for NetWare Print Services is available.

❒ If you configure the Network Interface Board in a NetWare environment us-
ing the NIB Setup Tool, you should install the client software released from
Novell in the following cases.

• Windows 95/98/Me in NDS mode configuration

• Windows NT 4.0 in NDS mode configuration

• Windows NT 4.0 in Bindery mode configuration

• Windows 2000 in NDS mode configuration

• Windows 2000 in Bindery mode configuration

• Windows XP in NDS mode configuration

• Windows XP in Bindery mode configuration

AAAA Log on to the Netware file server or the NDS tree as an Admin or Admin
equivalent.

BBBB Run the NIB Setup Tool.

Reference

 p.52 “Running the NIB Setup Tool” 

CCCC Click [Wizard] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

DDDD Click [IPX protocol].
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EEEE Click to select the IPX address of the Network Interface Board you are con-
figuring, and then click [Next >].

Note

❒ If you do not know which Network Interface Board you are configuring,
print a system configuration list to check the MAC address (Network ad-
dress).

FFFF Make sure that the MAC address and IPX address are correct, and click [Fin-
ish].

GGGG Type the print server name into the [Device Name] box, and click [Next >].

The default setting is “RDP_” followed by the 6 digit serial number. We rec-
ommend that you change it to something that is easier to remember or some-
thing based on the structure of the network.

HHHH In a dialog box for selecting a network environment, click to select the [Net-
Ware] check box and click to clear the [TCP/IP] check box.

IIII Click [Next >].

A dialog box for configuring the NetWare environment appears.

JJJJ Select [Bindery] when printing under Bindery mode, or select [NDS] when
printing under NDS mode.

When you are using NetWare version 4.x, you should select [NDS].

KKKK If you selected [Bindery], type into the [File Server Name:] box the name of the
file server in which a print server is to be created.

After clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

LLLL If you selected [NDS], type into the [Tree:] box the name of the NDS tree in
which the print server is created, and type the context into the [Context:] box.

Clicking [Browse], you can select an NDS tree and an NDS context among
those listed in the [Browse] dialog boxes.

As a context, object names are typed from a lower object and divided by a pe-
riod. For example, if you want to create a print server into NET under DS,
type “NET.DS”.

MMMM Click [Next >].
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NNNN Type the name of the machine into the [Printer Name] box, and the name of
the print queue into the [Print Queue Name] box.

The default setting for Printer Name is “Print Server Name” followed by “_1”
and for Print Queue Name is “Print Server Name” followed by “_Q” (quota-
tion marks are not included). You can change them if necessary.

OOOO If you have selected the NDS mode, type the volume of the print queue into
the [Queue Volume] box. 

Clicking [Browse], you can select one of those shown in the [Browse] dialog
box.

PPPP Click [Next >].

A dialog box to acknowledge the printing environment appears.

QQQQ Check the environment, and then click [Next >].

If you want to change the settings, click [< Back] and make the settings again.

Clicking [Next >], the NIB Setup Tool automatically creates the Print Server,
the Printer, and the Print Queue in the NetWare network.

RRRR After the confirmation dialog box appears, select [Quit] and click [Finish] to
exit the NIB Setup Tool.
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NetWare 3.x - Advanced Settings

The actual procedures for configuring the machine vary depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure the machine in the NetWare 3.x en-
vironment.

Preparation

The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. See p.53 “Quick Setup Using the NIB Setup Tool Wizard”.

Note

❒ This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.
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Setting Up as a Print Server

AAAA Log on to the file server as a Supervisor or a Supervisor equivalent.

BBBB Run the NIB Setup Tool.

Reference

 p.52 “Running the NIB Setup Tool” 

CCCC Click [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

DDDD Click [IPX protocol].

EEEE Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

Note

❒ If you do not know which Network Interface Board you are configuring,
see the system configuration list to check the MAC address (Network Ad-
dress).

FFFF Make sure that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

GGGG Click [Configure].

The property sheet appears.

HHHH Click the [General] tab, and type the name of the print server into the [Device
Name] box.

IIII Click the [NetWare] tab, and make the following settings.

A Select [Bindery].

B In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Click [Browse] to select a file server among those listed in the [Browse] dia-
log box.

C Click [OK] to close the property sheet.

D After the confirmation dialog box appears, click [OK].

JJJJ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

KKKK Type “PCONSOLE” from the command prompt.

F:> PCONSOLE
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LLLL Create a print queue as follows:

Note

❒ If you use a currently defined print queue, go to step M.

A From the [Available Options] menu, select [Print Queue Information] and press
the {{{{ENTER}}}} key.

B Press the {{{{INSERT}}}} key and type a print queue name.

C Press the {{{{ESC}}}} key to return to the [Available Options] menu.

MMMM Create a printer as follows:

A From the [Available Options] menu, select [Print Server Information] and press
the {{{{ENTER}}}} key.

B To create a new print server, press the {{{{INSERT}}}} key and type a print serv-
er name.

If you use a currently defined print server, select one of the print servers
shown in the [Print Server] list.

Important

❒ Use the same name as that specified in the NIB Setup Tool. (Step H).

C From the [Print Server Information] menu, select [Print Server Configuration].

D From the [Print Server Configuration] menu, select [Printer Configuration].

E Select the printer which is indicated as “Not Installed”.

F If you want to change the name of the printer, type a new name.

A name “Printer x” is assigned to the printer. “x” stands for the number of
the selected printer.

G For type, select [Remote Other/Unknown].

The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

H Press the {{{{ESC}}}} key, and click [Yes] in the confirmation dialog box.

I Press the {{{{ESC}}}} key to return to the [Print Server Configuration] menu.

NNNN Assign print queues to the created printer as follows:

A From the [Print Server Configuration] menu, select [Queues Serviced By Printer].

B Select the printer created in step MMMM.

C Press the {{{{INSERT}}}} key to select a queue serviced by the printer. 

Note

❒ You can select more than one queue at a time.

D Follow the instructions on the screen to make other necessary settings.

When you have finished the previous steps, make sure that the queues are
assigned.
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OOOO Press the {{{{ESC}}}} key until “EXIT?” appears, and select [Yes] to exit PCON-
SOLE.

Note

❒ To make sure that the machine is correctly configured, type the following
from the command prompt.

F:> USERLIST

❒ If the machine works as configured, the name of the print server appears
as an attached user.

Setting Up as a Remote Printer

AAAA Log on to the file server as a Supervisor or a Supervisor equivalent.

BBBB Run the NIB Setup Tool.

Reference

 p.52 “Running the NIB Setup Tool” 

CCCC Click [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

DDDD Click [IPX protocol].

EEEE Click the IPX address of the Network Interface Board to be configured, and
click [Next >].

Note

❒ If you do not know which Network Interface Board you are configuring,
see the system configuration list to check the MAC address (Network Ad-
dress).

FFFF Make sure that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

GGGG Click [Configure].

The property sheet appears.

HHHH Click the [General] tab, and type the name of the print server into the [Device
Name] box.
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IIII Click the [NetWare] tab, and make the following settings.

A In the [Print Server Name:] box, type the name of the print server.

B In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Click [Browse] to select a file server among those listed in the [Browse] dia-
log box.

C In the [Print Server Operation Mode] group, click [As Remote Printer].

D In the [Remote Printer No.] box, type the printer number.

Important

❒ Use the same printer number as that to be created in the print server.

E Click [OK] to close the property sheet.

F After the confirmation dialog box appears, click [OK].

JJJJ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

KKKK Type “PCONSOLE” from the command prompt.

F:> PCONSOLE

LLLL Create a print queue as follows:

Note

❒ If you use a currently defined print queue, go to step M.

A From the [Available Options] menu, select [Print Queue Information] and press
the {{{{ENTER}}}} key.

B Press the {{{{INSERT}}}} key and type a print queue name.

C Press the {{{{ESC}}}} key to return to the [Available Options] menu.

MMMM Create a printer as follows.

A From the [Available Options] menu, select [Print Server Information] and press
the {{{{ENTER}}}} key.

B To create a new print server, press the {{{{INSERT}}}} key and type a print serv-
er name.

If you use a currently defined print server, select one of the print servers
shown in the [Print Server] list.

Important

❒ Use the same name as that specified in the NIB Setup Tool. (Step H).

C From the [Print Server Information] menu, select [Print Server Configuration].

D From the [Print Server Configuration] menu, select [Printer Configuration].

E Select the printer which is indicated as “Not Installed”.

Important

❒ Use the same number as that specified as Remote Printer No. using the
NIB Setup Tool. (Step I-D).
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F Type a new name, if you change the name of the printer, .

A name “Printer x” is assigned to the printer. “x” stands for the number of
the selected printer.

G Select [Remote Parallel, LPT1,] for type.

The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

H Press the {{{{ESC}}}} key, and click [Yes] in the confirmation dialog box.

I Press the {{{{ESC}}}} key to return to [Print Server Configuration Menu].

NNNN Assign print queues to the created printer as follows:

A From [Print Server Configuration Menu], select [Queues Serviced By Printer].

B Select the printer created in step MMMM.

C Press the {{{{INSERT}}}} key to select a queue serviced by the printer. 

Note

❒ You can select more than one queue at a time.

D Follow the instructions on the screen to make other necessary settings.

When you have finished the above steps, make sure that the queues are as-
signed.

OOOO Press the {{{{ESC}}}} key until “Exit?” appears, and select [Yes] to exit PCON-
SOLE.

PPPP Start the print server by typing the following from the console of the Net-
Ware Server.

 If it is running, restart it after exiting it.

❖❖❖❖ To exit

CAREE: unload pserver

❖❖❖❖ To start

CAREE: load pserver print_server_name

Note

❒ If the machine works as configured, “Waiting for job” appears.
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NetWare 4.x, 5/5.1 - Advanced Settings

The actual procedures for configuring the machine vary depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure it in the NetWare 4.x, 5/5.1 environ-
ment.

❖❖❖❖ To use NetWare 5/5.1

• If you use Pure IP, configure the machine to use the TCP/IP protocol. For
more information about how to make the settings, see Printer Reference 1.

Preparation

The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. See p.53 “Quick Setup Using the NIB Setup Tool Wizard”.

Note

❒ This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.

❒ You should install the client software released from Novell in Windows be-
fore running the NIB Setup Tool for configuring in NDS mode or using Win-
dows NT 4.0.
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Setting Up as a Print Server

Important

❒ You can set up the print server using the NDS or Bindery mode in NetWare
4.x, 5/5.1. The following procedure is for setting up the print server using the
NDS mode in NetWare 4.1. When you set up the print server using the Bind-
ery mode, use the NIB Setup Tool Wizard. See p.53 “Quick Setup Using the
NIB Setup Tool Wizard”.

Note

❒ If you use Pure IP in NetWare 5/5.1, follow the procedure on p.65 “Using
Pure IP in the NetWare 5/5.1 environment”.

AAAA Log on to the file server as an Admin or an Admin equivalent.

BBBB Run the NIB Setup Tool.

Reference

 p.52 “Running the NIB Setup Tool” 

CCCC Click [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

DDDD Click [IPX protocol].

EEEE Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

Note

❒ If you do not know which Network Interface Board you are configuring,
see the system configuration list to check the MAC address (Network Ad-
dress).

FFFF Make sure that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

GGGG Click [Configure].

The property sheet appears.

HHHH Click the [General] tab, and type the name of the print server into the [Device
Name] box.

IIII Click the [NetWare] tab, and make the following settings.

A In the [Print Sever Name:] box, type the name of the print sever.
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B In the [File Sever Name:] box, type the name of the file sever in which a
print server is to be created.

Click [Browse] to select a file server among those listed in the [Browse] dia-
log box.

C In the [NDS Context:] box, type the context in which the print server is to
be created.

Click [Browse] to select a context among those listed in the [Browse] dialog
box.

As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type “NET.DS”.

D Click [OK] to close the property sheet.

E After the confirmation dialog box appears, click [OK].

JJJJ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

KKKK From Windows, run NWAdmin.

Reference

For more information about NWAdmin, see the documentation that comes
with the NetWare.

LLLL Create a print queue as follows:

A Select the container object the print queue is located in among those in
the directory tree, and click [Create] on the [Object] menu.

B In the [Class of new object] box, click “Print Queue”, and click [OK].

C In the [Print Queue name] box, type the name of the print queue.

D In the [Print Queue volume] box, click the [Browse] button.

E In the [Available objects] box, click the volume in which the print queue is
created, and click [OK].

F Check the settings, and then click [Create].

MMMM Create a printer as follows:

A Select the container object the printer is located in, and click [Create] on
the [Object] menu.

B In the [Class of new object] box, click “Printer”, and click [OK]. When you
are using NetWare 5/5.1, click “Printer (Non NDPS)”.

C In the [Printer name] box, type the name of the printer.

D Select the [Define additional properties] check box, and click [Create].
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NNNN Assign print queues to the created printer as follows:

A Click [Assignments], and click [Add] in the [Assignments] group.

B In the [Available objects] box, click the queue created in step LLLL, and click
[OK].

C Click [Configuration], and in the [Printer type] box, select [Parallel] using the
drop-down menu, and then click [Communication]. 

D Click [Manual load] in the [Communication type] group, and click [OK].

E Check the settings, and then click [OK].

OOOO Create a print server as follows:

A Select the context specified using the NIB Setup Tool (step IIII-AAAA), and on
the [Object] menu, click [Create].

B In the [Class of new object] box, click “Print Server”, and click [OK]. When
you are using NetWare 5/5.1, click “Print Server (Non NDPS)”.

C In the [Print Server name] box, type the name of the print server.

Important

❒ Use the same name as that specified using the NIB Setup Tool. (Step H)

D Select the [Define additional properties] check box, and click [Create].

PPPP Assign the printer to the created print server as follows:

A Click [Assignments], and click [Add] in the [Assignments] group.

B In the [Available objects] box, click the printer created in step MMMM, and click
[OK].

C Check the settings, and then click [OK].

Note

❒ If the machine works as configured, the name of the print server ap-
pears as an attached user.

Using Pure IP in the NetWare 5/5.1 environment

AAAA Log on to the file server as an Admin or an Admin equivalent.

BBBB Run the NIB Setup Tool.

Reference

 p.52 “Running the NIB Setup Tool” 

CCCC Click [Property Sheet] and click [OK].

The [Network board list] dialog box appears.

DDDD Click [TCP/IP protocol].
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EEEE Click the IP address of the Network Interface Board which is to be config-
ured, and then click [Next >].

Note

❒ If you do not know which Network Interface Board you are configuring,
see the system configuration list to check the MAC address (Network Ad-
dress).

FFFF Make sure that the MAC address and IP address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

GGGG Click [Configure].

The property sheet appears.

HHHH Click the [General] tab, and type the name of the print server into the [Device
Name:] box.

IIII Click the [NetWare] tab, and make the following settings.

A In the [Print Server Name:] box, type the name of the print server.

B In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Click [Browse] to select a file server among those listed in the [Browse File
Server] dialog box.

C In the [NDS Context:] box, type the context of the print server.

Click [Browse] to select an NDS tree and an NDS context among those listed
in the [Browse Context] dialog box.

As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type “NET.DS”.

D In the [Print Server Operation Mode] group, click [As Print Server].

E Click [OK] to close the property sheet.

F After the confirmation dialog box appears, click [OK].

JJJJ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

After this step, go to step K on p.63 “Setting Up as a Print Server”.
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Setting Up as a Remote Printer

AAAA Log on to the file server as an Admin or an Admin equivalent.

BBBB Run the NIB Setup Tool.

Reference

 p.52 “Running the NIB Setup Tool” 

CCCC Click [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

DDDD Click [IPX protocol].

EEEE Click the IPX address of the Network Interface Board to be configured, and
click [Next >].

Note

❒ If you do not know which Network Interface Board you are configuring,
see the system configuration list to check the MAC address (Network Ad-
dress).

FFFF Make sure that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

GGGG Click [Configure].

The property sheet appears.

HHHH Click the [General] tab, and type the name of the print server into the [Device
Name] box.

IIII Click the [NetWare] tab, and make the following settings.

A In the [Print Server Name:] box, type the name of the print server.

B In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Click [Browse] to select a file server among those listed in the [Browse] dia-
log box.
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C In the [NDS Context:] box, type the context in which the print server is to
be created.

Click [Browse] to select a context among those listed in the [Browse] dialog
box.

As a context, object names are typed from a lower level object and divided
by a period. For example, if you want to create a print server into NET un-
der DS, type “NET.DS”.

D In the [Print Server Operation Mode] group, click [As Remote Printer].

E In the [Remote Printer No.] box, type the printer number.

Important

❒ Use the same printer number as that of the printer to be created in the
print server.

F Click [OK] to close the property sheet.

G After the confirmation dialog box appears, click [OK].

JJJJ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

KKKK From Windows, run NWAdmin.

Reference

For more information about NWAdmin, see the documentation that comes
with the NetWare.

LLLL Create a print queue as follows:

A Select the container object the print queue is located in among those in
the directory tree, and click [Create] on the [Object] menu.

B In the [Class of new object] box, click “Print Queue”, and click [OK].

C In the [Print Queue name] box, type the name of the print queue.

D In the [Print Queue Volume] box, click [Browse] button.

E In the [Available objects] box, click the volume in which the print queue is
created, and click [OK].

F Check the settings, and then click [Create].

MMMM Create a printer as follows:

A Select the container object the printer is located in, and click [Create] in
the [Object] menu.

B In the [Class of new object] box, click “Printer”, and click [OK]. When you
are using NetWare 5/5.1, click “Printer (Non NDPS)”.
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C In the [Printer name] box, type the name of the printer.

D Select the [Define additional properties] check box, and click [Create].

NNNN Assign print queues to the created printer as follows:

A Click [Assignments], and click [Add] in the [Assignments] group.

B In the [Available objects] box, click the queue created in step LLLL, and click
[OK].

C Click [Configuration], and in the [Printer type] box, select [Parallel] using the
drop-down menu, and then click [Communication]. 

D Click [Manual load] in the [Communication type] group, and click [OK].

E Check the settings, and then click [OK].

OOOO Create a print server as follows:

A Select the context specified using the NIB Setup Tool (Step IIII-AAAA), and on
the [Object] menu, click [Create].

B In the [Class of new object] box, click “Print Server”, and click [OK]. When
you are using NetWare 5/5.1, click “Print Server (Non NDPS)”.

C In the [Print Server name] box, type the name of the print server.

Important

❒ Use the same name as that specified using the NIB Setup Tool. (Step H).

D Select the [Define additional properties] check box, and click [Create].

PPPP Assign the printer to the created print server as follows:

A Click [Assignments], and click [Add] in the [Assignments] group.

B In the [Available objects] box, click the queue created in the step MMMM, and
click [OK].

C In the [Printers] group, click the printer assigned in step BBBB, and click
[Printer Number].

D Type the printer number and click [OK].

Important

❒ Use the same number as that specified as Remote Printer No. using the
NIB Setup Tool. (Step I-E).

E Check the settings, and then click [OK].

QQQQ Start the print server by typing the following from the console of the Net-
Ware Server.

If it is running, restart it after exiting it.

❖❖❖❖ To exit
CAREE: unload pserver

❖❖❖❖ To start
CAREE: load pserver print_server_name
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Setting Up a Client Computer

This section describes how to set up a client computer when using a NetWare
print server.

Note

❒ This section assumes that the client has NetWare client applications installed
and is correctly configured to communicate with a NetWare print server. If
not, install the necessary applications before starting the setting up proce-
dure.

Windows 95/98/Me

Follow the procedure to set up a Windows 95/98/Me client. 

Preparation

Log on to the NetWare file server before starting the following procedure.

AAAA Install the printer driver you want to use as “Local printer”.

Reference

For more information about installing the printer driver, see Printer Refer-
ence 1.

Note

❒ Any port can be selected during the installation, however, LPT1 is recom-
mended.

BBBB Click [Start], point to [Settings], and then click [Printers].

CCCC In the [Printers] window, click the icon of the machine you want to use. 

DDDD On the [File] menu, click [Properties].

EEEE Click the [Details] tab, and click [Add Port].

FFFF Click [Network] and click [Browse].

GGGG On the network tree, double-click the name of the file server.

The queues are displayed.

HHHH Click the queue you want to print, and click [OK].

IIII Click [OK].

In the [Print to the following port:] box, a network path to the printer appears.

JJJJ Click [OK] to close the Printer Properties, and again, open it.
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KKKK Click the [Printer Settings] tab.

LLLL Select to clear the [Form feed] and [Enable banner] check boxes.

Note

❒ You should not select these boxes because they should be specified using
the printer driver. If they are selected, the printer might not print correctly.

When using the PostScript printer driver

Follow these steps to set up for the PostScript printer driver.

A Click the [PostScript] tab. 

B Click [Advanced].

C Click to clear the [Send CTRL+D before job] and [Send CTRL+D after job] check
boxes.

MMMM Click [OK] to close the Printer Properties.

Windows 2000/Windows XP

Follow the procedure to set up a Windows 2000/Windows XP client.

Preparation

Log on to the NetWare file server before starting the following procedure.

AAAA Double-click the [My Network Places] icon on the desktop and navigate to the
queue you want to use, and then double-click it.

The printers dialog box appears.

BBBB Click [No].

CCCC Close all the applications that are currently running.

DDDD Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

EEEE Install the printer driver.

Reference

For more information about installing the printer driver, see Printer Refer-
ence 1.

FFFF From the [Port] list, select the queue you selected in step AAAA, and click [Next >].

GGGG Follow the instructions on the screen to complete the installation of the
printer driver.
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Windows NT 4.0

Follow the procedure to set up a Windows NT 4.0 client.

Preparation

Log on to the NetWare file server before starting the following procedure.

AAAA Double-click the [Network Neighborhood] icon on the desktop and navigate to
the queue you want to use, and then double-click it.

The [Printers] dialog box appears.

BBBB Click [No].

CCCC Close all the applications that are currently running.

DDDD Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

EEEE Install the printer driver.

Reference

For more information about installing the printer driver, see Printer Refer-
ence 1.

FFFF From the [Port] list, select the queue you selected in step AAAA, and click [Next >].

GGGG Follow the instructions on the screen to complete the installation of the
printer driver.
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Configuring Macintosh

Note

❒ Only Type80 RCP80 can be used on Macintosh.

This section describes how to configure a Macintosh computer to use EtherTalk.
The actual procedures to configure a Macintosh may vary depending on the ver-
sion of Mac OS. The following procedure describes how to configure Mac OS 9.1
and Mac OS Χ version 10.1. If you are using other version of Mac OS and Mac
OS Χ, see the manual that comes with your version of Mac OS and Mac OS Χ for
more information.
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Changing to EtherTalk

The following procedure is for configuring a Macintosh computer to use
EtherTalk.

Reference

For more information about installing the software required for EtherTalk,
see the Macintosh manuals.

Mac OS

AAAA Open [Control Panels], and double-click the [AppleTalk] icon.

BBBB From the [Connect via:] pop-up menu, select “Ethernet”.

CCCC If you change zones, select a name from the [Current zone:] pop-up menu.

DDDD Close the [AppleTalk] control panels.

EEEE Restart the Macintosh.

Mac OS ΧΧΧΧ

Preparation

You need an administrator name and a password (phrase). For more informa-
tion, consult your administrator.

AAAA Open [System Preference], and then click the [Network] icon.

BBBB Click the [AppleTalk] tab.

CCCC If you change zones, select a name from the [AppleTalk Zone:] pop-up menu.

DDDD When the setting is complete, click [Apply Now].

Configuring the Printer

Use the control panel to activate the EtherTalk protocol. (The default is active.)

Reference

For more information about configuration, see Printer Reference 1.



Configuring Macintosh

75

6

Changing the Printer Name

If the network has several same model printers, the names will be the same.
Printers that have the same name will have their names changed slightly in the
Chooser on Mac OS or Printer list on Mac OS Χ. For example, three printers
named “printer” will appear in the chooser as “printer0”, “printer1” and
“printer2”. 

Use applications such as Apple Printer Utility or LaserWriter Utility to change
printer names in the Macintosh EtherTalk environment. These utilities are dis-
tributed by Apple Computer, Inc.

Changing the Zone

It may be necessary to change the zone configuration.

Use applications such as Apple Printer Utility or LaserWriter Utility to change
the zone configuration in the Macintosh EtherTalk environment. These utilities
are distributed by Apple Computer, Inc.

Note

❒ If the Macintosh is configured to use TCP/IP, you can change the zone con-
figuration with a Web Browser. See p.80 “Configuring the Network Interface
Board with a Web Browser”.

Follow these steps to use the Apple Printer Utility.

A Insert the CD-ROM into the CD-ROM drive.

B Copy the “Zone Name.ps” file in the “Zone Name” folder to the hard disk.

C Open the copied “Zone Name.ps” file using a text editor, and change “New-
Zone”, which is in the second line from the bottom, to the name of the new
zone.
%!PS-Adobe2.0
%%Title: Changing Zone (EtherNet only)
%%CreationDate: Tue Dec 16 1997
%%EndComments
true 0 startjob not {ERROR} if
(%EtherTalk%) << /EtherTalkZone (NewZone) >> setdevparams
%%EOF

D Save “Zone Name.ps”.

E Run the Apple Printer Utility, and select the printer for which the new zone
name is to be used.

F Select [Send PostScript File] in the [Utilities] menu, and send “Zone Name.ps” to
the printer.
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7. Appendix

Using SmartDeviceMonitor for Admin

Using SmartDeviceMonitor for Admin, you can not only monitor the status of
network printers, but also change the configuration of the Network Interface
Board using the TCP/IP protocol or IPX/SPX protocol.

SmartDeviceMonitor for Admin can do the following.

• Limit the settings available from the control panel, and disable changes made
to some items.

• Enable selecting the paper type loaded in the printer.

• Check information about printing, paper exhaustion, and such on the compu-
ter.

• Monitor multiple printers at the same time. When there are many printers,
you can create groups and classify the printers to facilitate management.

• Check the printer's network settings and detailed information of devices.

• Enable you to change the printer's network settings.

• Check the number of pages printed for each computer using the user codes.

Note

❒ Select the appropriate protocol stack for your operating system.

OS Protocol Stack

Microsoft Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me

NetWare network client provided with Windows 95/98

Novell Client for Windows 95/98

Microsoft Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client for Windows NT/2000

Microsoft Windows XP TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

Microsoft Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

Client Service for NetWare provided with Windows 
NT

Novell Client for Windows NT/2000
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Changing the Network Interface Board Configuration

AAAA Run SmartDeviceMonitor for Admin.

BBBB Click the [Group] menu, point to [Open LAN], and then select [TCP/IP] or
[IPX/SPX]. A list of printers appears.

Note

❒ Select the protocol of the printer for which you want to change the config-
uration.

CCCC On the list, select a printer for which you want to change the configuration.

DDDD From the [Tools] menu, select [NIB Setup Tool].

The NIB Setup Tool starts up.

EEEE Select [Wizard] or [Property Sheet], and then click [Next].

• When configuring the Network Interface Board for the first time, select
[Wizard].

• When changing the configuration of the Network Interface Board or con-
figuring it in detail, select [Property Sheet].

Selecting [Wizard]

A Fill in the necessary items, and then click [Next].

Selecting [Property Sheet]

A A configuration list appears on the dialog box.

For more information about each item on the dialog box, see Help.
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Managing the printed number of pages

AAAA Run SmartDeviceMonitor for Admin.

BBBB Click the [Group] menu, point to [Open LAN], and then select [TCP/IP] or
[IPX/SPX].

A list of printers appears.

Note

❒ Select the protocol of the printer for which you want to change the config-
uration.

CCCC On the list, select a printer whose statistics information you want to man-
age.

DDDD From the [Tools] menu, select [User Management Tool].

A dialog box prompting you to type a password appears.

EEEE Type the password, and then click [OK].

Note

❒ The factory default password is “password”.

The User Code Maintenance Tool starts up.

For more information about using the User Management Tool, see SmartDe-
viceMonitor for Admin Help.
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Configuring the Network Interface Board 
with a Web Browser

The Network Interface Board functions as a Web server in addition to allowing
the machine to function as a network printer. You can use a Web Browser to
view the printer status and configure the Network Interface Board.

❖❖❖❖ Configuring the machine
This requires the TCP/IP protocol to be installed. After the machine has been
configured to use the TCP/IP protocol, it will be possible to adjust the settings
using a Web Browser.

Reference

For more information about configuring the machine to use the TCP/IP
protocol, see Printer Reference 2.

❖❖❖❖ Operating system browser requirements

*1 Only Type80 RCP80 can be used on Macintosh.

Limitation

❒ Sometimes after clicking [Back] , the previous page may not appear. In this
case, click [Refresh] or [Reload] .

❒ The text on the screen may disappear or be aligned incorrectly if the font
size settings of the browser are too large. It is recommended that you use
a font size equal to or smaller than “10 point” with Netscape Navigator,
and “Medium” or smaller with Internet Explorer.

OS Browser

Windows 95/98/Me

Microsoft Internet Explorer 3.02/4.0 or later

Netscape Navigator 3.0/4.0 or later

Windows 2000

Windows XP

Windows NT 4.0

Mac OS 7.6.1 ∼ 9.2 *1 

Mac OS Χ *1 

Solaris 2.5 ∼ 2.6
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Going to the Top Page

After launching the Web Browser, type the IP address of the machine. See the
example below. This example is for the English version.

http://192.168.15.16/

(In this example, the IP address of the Network Interface Board is 192.168.15.16.)

Note

❒ If a DNS server is used on the network, you can type the host name as an URL.
For example, http://webmonitor.netprinter.com/. In order to do this, you
must register the IP address and host name of the Network Interface Board
with the DNS server. Consult the network administrator for information
about how to do this.

❒ If you want to use any equipment in the proxy server network environment,
stop the proxy server or temporarily stop access to the proxy server from the
equipment.

1. Header Buttons

You can register favorite URLs with
[URL]. To view the Help section, click
[Help].

Important

❒ When connecting via a dial-up
connection, please be aware that
there will be a communication
charge as you are logging onto the
Internet.

Note

❒ Help is stored in the following folder
on the CD-ROM in HTML format. The
third folder, “(Language)” may be
substituted by an appropriate lan-
guage name.

\HELP\WSMHLP\(Language)\

2. Menu Buttons

Buttons to configure the Network Inter-
face Board and confirm the status of the
machine.

Note

❒ When you click [Network Config], a dia-
log box appears requesting the user
name and the password. Type only
the password in this dialog box. The
factory default password is “pass-
word”.

❒ The password is the same as that used
for remote maintenance and that used
in the NIB Setup Tool. If you change a
password with the Web Browser, the
other passwords are also changed.

3. Status

Displays the name and comments of the
Network Interface Board, and the printer
status.
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Verifying the Network Interface Board Settings

AAAA Start the Web browser.

BBBB Point your browser at the URL or IP address of the printer (e.g. ht-
tp://XXX.XXX.XXX.XXX where the Xs are the numbers of the IP address).

The status of the printer you chose appears on the Web browser.

CCCC Click [Config. Reference].

The dialog box for entering the password and user name is displayed.

DDDD Click the item you want to check.

The following items can be checked:

❖❖❖❖ [General]
Shows the general settings for the machine.

❖❖❖❖ [TCP/IP]
Shows the TCP/IP-related settings for the Network Interface Board.

❖❖❖❖ [NetWare]
Shows the settings for printing in a NetWare environment.

❖❖❖❖ [AppleTalk]
Shows the Network Interface Board settings related to the AppleTalk pro-
tocol.

❖❖❖❖ [NetBEUI]
Shows the Network Interface Board settings related to the NetBEUI proto-
col.
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----Linking the address (URL) to the [Help] button

You can link the address (URL) of the [Help] button to the Help files on the com-
puter or on a Web server.

A Copy the Help files on the CD-ROM to the desired location. The Help files are
located in folders labeled with abbreviated language names. For example,
English Help files are in the [EN] folder. Be sure to copy the entire [EN] folder
to the new location.

B Using a Web Browser, navigate to the Top Page and click [Network config.].

C Type your password, (it is not necessary to type a user name) and click [OK].

D Type the path to the Help files in the [Help URL] box.
If you copied the Help files to “C:\HELP\EN” , type “file://C:/HELP/”. For
example if you copied the files to a web server and the index URL is “ht-
tp://a.b.c.d/HELP/EN/index.html”, type “http://a.b.c.d/HELP/”.

E Click [Apply].
When a warning message appears, select to continue configuration.

Configuring the Network Interface Board Settings

AAAA Start the Web browser.

BBBB Point your browser at the URL or IP address of the printer (e.g. ht-
tp://XXX.XXX.XXX.XXX where the Xs are the number of the IP address).

The status of the printer you chose appears on the Web browser.

CCCC Click [Network Config].

The dialog box for entering the password and user name is displayed.

DDDD Enter your user name and password, and then click [OK].

To use the factory default account, enter no user name and type “password”
for the password.

EEEE Click the item you want to configure, and then make all the settings.

The following items can be configured:

❖❖❖❖ [General]
Configure the general settings for the machine here.

❖❖❖❖ [TCP/IP]
Configure the TCP/IP-related settings for the Network Interface Board.
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❖❖❖❖ [SNMP]
Configure the appropriate community settings here. Up to 10 types of
community names can be registered.

❖❖❖❖ [NetWare]
Configure the settings for printing in a NetWare environment here.

❖❖❖❖ [AppleTalk]
Configure the Network Interface Board settings related to the AppleTalk
protocol.

❖❖❖❖ [NetBEUI]
Configure the Network Interface Board settings related to the NetBEUI
protocol here.

❖❖❖❖ [IPP Authentication]
If using the IPP protocol, configure the authentication settings for printing
here.

❖❖❖❖ [Password]
Enter the password to change the network and machine settings or delete
spooled print jobs.
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Monitoring and Configuring the Printer

Changing Names and Comments

You can change printer names and make comments for printers to easily identify
the printers listed on SmartDeviceMonitor for Client.

The following utilities are used to change printer names and comments.

❖❖❖❖ SmartDeviceMonitor for Admin
Allows you to change names and comments when the TCP/IP protocol or
IPX/SPX protocol is available. You can install SmartDeviceMonitor for Ad-
min from the CD-ROM that comes with the printer. For more information
about installing SmartDeviceMonitor for Admin, see Setup Guide.

❖❖❖❖ Web Browser
Allows you to change names and comments when the TCP/IP protocol is
available.

Note

❒ Each of the names, one for the TCP/IP protocol form (printer name) and
NetBEUI protocol form, is changed individually. However comments are
common to both of them.

❒ The factory default name consists of “RNP” and the last 3 bytes of the
MAC address on the Network Interface Board. For example, when the
MAC address is 00:00:74:62:7D:D5, the factory default name is
“RNP627DD5”. Comments are not configured.

SmartDeviceMonitor for Admin

AAAA Run SmartDeviceMonitor for Admin.

BBBB Click the [Group] menu, point to [Open LAN], and select [TCP/IP] or [IPX/SPX].
A list of printers appears.

Note

❒ Select the protocol of the printer for which you want to change the config-
uration.

CCCC On the list, select a printer whose Network Interface Board configuration
you want to change.

DDDD From the [Tools] menu, select [NIB Setup Tool].

The NIB Setup Tool starts up.
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EEEE Select [Property Sheet], and then click [OK].

TCP/IP

A Click the [General] tab, and then type the device name into the [Device
Name] box and a comment into the [Comment] box.

• In the [Device Name] box, type the name of the printer using less than 13
characters. The factory default name consists of “RNP” and the last 3
bytes of the MAC address on the Network Interface Board. For example,
when the MAC address is 00:00:74:62:7D:D5, the factory default name is
“RNP627DD5”. No name of 9 characters is permitted if the prefix is
“RNP”. Also, when DHCP is selected as an IP address setting, the
number of characters is limited to 13 characters.

• In the [Comment] box, type a comment about the printer using less than
31 characters.

NetBEUI

A Click the [General] tab, and then type a comment into the [Comment] box.

In the [Comment] box, type a comment about the printer using less than 31
characters.

B Click the [NetBEUI] tab.

C Type the computer name into the [Computer Name] box.

• In the [Computer Name] box, type a name that helps you to identify a
printer using the NetBEUI protocol. The factory default name consists
of “RNP” and the last 3 bytes of the MAC address on the Network In-
t e r f a c e  B o a r d .  F o r  e x am p le ,  w h en  t h e  M A C  a d d r e s s  i s
00:00:74:62:7D:D5, the factory default name is “RNP627DD5”. A maxi-
mum of 13 characters consisting of uppercase English letters, numbers,
or symbols (except "*+,/:;<=>?[\]|. and space) can be used. No name is
permitted if the prefix is “RNP”. You must avoid using a name already
used.

• In the [Comment] box, type a comment about the printer using less than
31 characters.

FFFF Click [OK].

The NIB Setup Tool closes, and the settings are transmitted to the printer.

GGGG Exit SmartDeviceMonitor for Admin.
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Web Browser

AAAA Run the Web browser.

BBBB Type the address “http:// (IP address of the printer for which you want to
change the settings)”.

The status of the selected printer is displayed on the Web browser.

CCCC Click [Configuration].

A dialog box that prompts you to type the user name and a password appears.

DDDD Type the user name and the password, and then click [OK].

Type only the password in this dialog box. The factory default password is
“password”.

EEEE Change names and comments.

TCP/IP

A Click [General], and then type the name into the [Device Name:] box and a
comment into the [Comment] box.

• In the [Device Name:] box, enter the name of the printer using less than 13
characters. The factory default name consists of “RNP” and the last 3
bytes of the MAC address on the Network Interface Board. For example,
when the MAC address is 00:00:74:62:7D:D5, the factory default name is
“RNP627DD5”. No name of 9 characters is permitted if the prefix is
“RNP”. Also, when DHCP is selected as an IP address setting, the
number of characters is limited to 13 characters.

• In the [Comment] box, type a comment about printer using less than 31
characters.

NetBEUI

A Click [NetBEUI].

B Type the name into the [Computer Name] box and a comment into the [Com-
ment] box.

• In the [Computer Name] box, type a name that helps you to identify print-
ers using the NetBEUI protocol. The factory default name consists of
“RNP” and the last 3 bytes of the MAC address on the Network Inter-
face Board. For example, when the MAC address is 00:00:74:62:7D:D5,
the factory default name is “RNP627DD5”. A maximum of 13 characters
consisting of uppercase English letters, numbers, or symbols (except
"*+,/:;<=>?[\]|. and space) can be used. No name is permitted if the
prefix is “RNP”. You must avoid using a name already used.

• In the [Comment] box, type a comment about the printer using less than
31 characters.
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FFFF Click [Apply].

The settings are transmitted to the printer.

GGGG Exit the Web browser.

Displaying the Status of Printers

You can view the status of printers using SmartDeviceMonitor for Admin,
SmartDeviceMonitor for Client, or Web browser.

SmartDeviceMonitor for Admin

AAAA Run SmartDeviceMonitor for Admin.

BBBB Click the [Group] menu, point to [Open LAN], and then select [TCP/IP] or
[IPX/SPX].

The status of printers is indicated with an icon in the list.

Note

❒ For more information about the status icons, see SmartDeviceMonitor for
Admin Help.

CCCC For more information, click to select the desired printer from the list, and
then click [Open] on the [Device] menu.

The status of the printer is displayed in the dialog box.

Note

❒ For more information about each item in the dialog box, see Help.

SmartDeviceMonitor for Client

To view the status of a printer using SmartDeviceMonitor for Client, you must,
in advance, configure SmartDeviceMonitor for Client so it monitors the printer
whose status you want to view.

Monitoring Printers

AAAA Run SmartDeviceMonitor for Client.

The “Welcome to SmartDeviceMonitor for Client” screen appears. 

Note

❒ Click on [Do not show this message again.] to stop the message being dis-
played each time you launch SmartDeviceMonitor for Client.

❒ The remaining instructions in this manual assume that this screen is not
displayed.
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BBBB Click [OK].

The SmartDeviceMonitor for Client icon appears at the right end of the taskbar.

CCCC Right-click the SmartDeviceMonitor for Client icon, and check if the de-
sired printer is configured on the pop-up menu that appears.

If it is configured, see SmartDeviceMonitor for Client Help.

DDDD If the desired printer is not configured, click [Options] on the pop-up menu.

The [SmartDeviceMonitor for Client - Options] dialog box appears.

EEEE Click the printer to be monitored, and select the [To Be Monitored] check box
from the [Monitoring Information Settings] group.

Note

❒ Selecting the [Displayed on Task Bar] check box will show the status of a print-
er with an icon on the SmartDeviceMonitor for Client icon on the task bar.

FFFF Click [OK].

The dialog box closes and the configured printer is monitored.

Displaying the Status of Printers

AAAA Run SmartDeviceMonitor for Client.

BBBB The status of printers is displayed on the SmartDeviceMonitor for Client
icon on the task bar.

Note

❒ For more information about the status icons, see SmartDeviceMonitor for
Client Help.

CCCC For more information on the status, right-click the SmartDeviceMonitor for
Client icon, and then click the desired printer.

The status of the printer is displayed in the dialog box.

Note

❒ For more information about each item in the dialog box, see Help.

Web Browser

AAAA Run the Web browser.

BBBB Type the address “http:// (IP address of the printer whose status you want to view)”.

The status of the selected printer is displayed in the Web browser.

CCCC Click [Status] and you can check the status of the printer.

Note

❒ For more information about each item, see Help.
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Assigning IP Address with ARP+PING

Using TCP/IP, you can assign the IP address using ARP and PING. The follow-
ing example is for a BSD UNIX workstation (SunOS 4.x).

Preparation

ARP+PING should be set to active on the network boot configuration before
assigning the IP address using ARP+PING. For more information about set-
ting it to active, see Printer Reference 1.

AAAA Log on to the workstation as root.

BBBB Use the arp command to assign the IP address to the MAC address of the
Network Interface Board.

# arp -s 192.168.15.16 00:00:74:62:5C:65

Note

❒ 192.168.15.16 is the IP address, 00:00:74:62:5C:65 is the MAC address.

CCCC Assign the IP address using the ping command.

# ping 192.168.15.16

DDDD Use the ping command again to confirm the address.

# ping 192.168.15.16

If the address has been configured correctly, the following message appears.

192.168.15.16 is alive

If the address has been configured incorrectly, the following message ap-
pears.

no answer from 192.168.15.16

----How to Confirm the MAC Address

The MAC address (Ethernet address) of the Network Interface Board is required
in order to use ARP and PING to assign the IP address.

The MAC address can be seen on the system configuration list.

Reference

For how to print the system configuration list, see Printer Reference 2.

Note

❒ The MAC address can also be seen on the system configuration list. For more
information about the system configuration list, see p.119 “System Configu-
ration List (Network Configuration)”.
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Remote Maintenance by telnet (mshell)

You can view the machine status and configure the Network Interface Board us-
ing telnet.

Note

❒ You should specify a password so that only the network administrator, or a
person having network administrator privileges, can use remote mainte-
nance. 

Using telnet

The following is a sample procedure in using telnet.

Limitation

❒ Only one person at a time can be logged on to do remote maintenance.

AAAA Using the IP address or host name of the machine, start telnet.

% telnet IP_address

Note

❒ In order to use the host name instead of the IP address, you must write it
to the /etc/hosts file.

BBBB Type the password.

Note

❒ The factory default is “password”.

CCCC Type a command.

Reference

 For more information about telnet commands, see p.92 “Commands List”.

DDDD Exit telnet.

msh> logout

When the configuration is changed, a confirmation message requests whether
or not the changes should be saved.

EEEE Type “yes” to save the changes, and press the {{{{ENTER}}}} key.

If you do not want to save the changes, type “no”and press the {{{{ENTER}}}} key.
If you want to make additional changes, type “return” at the command line,
and press the {{{{ENTER}}}} key.

Note

❒ If the “Cannot write NVRAM information” message appears, the changes
are not saved. Repeat the steps above.
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❒ The Network Interface Board is reset automatically when the settings are
changed.

❒ When the Network Interface Board is reset, the active print job which has
already been sent to the machine will finish printing. However, jobs that
have not been sent yet will be canceled.

Commands List

This is a list of commands that can be used via remote maintenance.

Note

❒ Type “help” to see a list of commands that can be used.

msh> help

❒ Type “help command_name” to display information about the syntax of that
command.

msh> help command_name

TCP/IP address

Use the ifconfig command to configure TCP/IP for the machine (IP address, sub-
net mask, broadcast address, default gateway address).

❖❖❖❖ Reference
msh> ifconfig

❖❖❖❖ Configuration
msh> ifconfig le0 parameter address

The following is an example for configuring an IP address of 192.168.15.16.

msh> ifconfig le0 192.168.15.16

The following is an example for configuring a subnet mask of 255.255.255.0.

msh> ifconfig le0 netmask 255.255.255.0

Note

❒ This affects the configuration of the Network Interface Board of the IP ad-
dress that is used.

❒ To type an address using hexadecimal, prefix it by “0x”.

Parameter Meaning

(no parameter) IP address

netmask subnet mask

gateway default gateway address



Remote Maintenance by telnet (mshell)

93

7

----Address

❖❖❖❖ Subnet Mask
A number used to mathematically “mask” or hide the IP address on the net-
work by eliminating those parts of the address that are alike for all the ma-
chines on the network.

❖❖❖❖ Default Gateway Address
A gateway is a connection or interchange point that connects two networks.
A gateway address is for the router or host computer used as a gateway.

Note

❒ To get the above addresses, contact your network administrator.

Access Control

Use the access command to view and configure access control.

You can also configure multiple access controls with the multi command.

❖❖❖❖ Reference
msh> access

❖❖❖❖ Configuration
msh> access parameter address

Note

❒ The Access Control Address and the Access Control Mask are used to limit
access to the computer used for printing by denying access to users based on
their IP address. If it is not necessary to limit access, set the Access Control
Mask to “0.0.0.0”.

❒ When the Access Control Address matches the masked result of the IP ad-
dress computer attempting to print, print jobs from that IP address will be ac-
cepted by the Network Interface Board.

Parameter Meaning

control Access Control Address

mask Access Control Mask
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❒ For example, if you assign 192.168.15.16 as the Access Control Address of the
Network Interface Board, the IP addresses that can print are as follows. XXX
means any number from 1 to 255 is acceptable.

❖❖❖❖ Configuration for multiple access controls
msh> access multi {on | off}
 •“on” means active and “off” means inactive.
msh> access {1 - 5} parameter address

Note

❒ Up to 5 access controls are available. Specify the number (1 - 5) when con-
figuring some access controls. If this is not configured, the first setting is
selected.

Network Boot

Use the set command to configure the boot method.

msh> set parameter {on | off}

 •“on” means active and “off” means inactive.

Note

❒ When you use RARP+TFTP, BOOTP or DHCP, the server also needs to be
configured.

❒ DHCP takes precedence over all other settings.

Access Control Mask IP addresses that can access the 
machine

  0.  0.  0.  0 XXX.XXX.XXX.XXX

255.  0.  0.  0 192.XXX.XXX.XXX

255.255.  0.  0 192.168.XXX.XXX

255.255.255.  0 192.168. 15.XXX

255.255.255.255 192.168. 15. 16

Parameter Meaning

ping ARP+PING

tftp RARP+TFTP

bootp BOOTP

dhcp DHCP (Dynamic Host Configuration 
Protocol)
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Protocol

Use the set command to allow/prevent remote access for each protocol.

msh> set protocol {up | down}

Note

❒ If you prohibit remote access using TCP/IP and then log out, you cannot use
remote access. If this was a mistake, you can use the machine's operation pan-
el to allow access by TCP/IP.

❒ When you prevent access via TCP/IP, you are also prevented from using lpr,
ftp, rsh, diprint, web, snmp, npmp, and ipp.

Machine status

The following commands can be used to get information about the current status
of the machine.

msh> command

Note

❒ More information about any print job is displayed when the ID number is
added after the prnlog command.

Reference

For more information about the meaning of the data returned with these com-
mands, see p.104 “Configuring the Network Interface Board”.

Protocol

AppleTalk

tcpip

netware

netbeui

lpr

ftp

rsh

diprint

npmp

web

snmp

ipp

“up” means active and “down” means 
inactive.

Command Information that is displayed

info Information about the paper tray, output tray 
and printer language of the machine.

netstat Information about the Network Interface 
Board. (Network Statistical Information)
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Network Interface Board configuration settings information

Use the show command to display the Network Interface Board configuration
settings.

msh> snmp [-p]

Note

❒ Add “-p” to the show command to have the information displayed one screen
at a time.

Reference

For more information about the meaning of the data returned with this com-
mand, see p.104 “Configuring the Network Interface Board”.

System log information

Use the syslog command to display information stored in the machine's system
log. 

msh> syslog

Reference

For more information about the displayed information, see p.107 “System
Log Information”.

SNMP

Use the snmp command to display and edit SNMP configuration settings such
as the community name.

Note

❒ You can configure from ten SNMP access settings numbered 1–10.

❒ Default access settings 1 and 2 are as follows.

❖❖❖❖ Display
Shows the SNMP information and available protocols.

msh> snmp ?
msh> snmp [-p] [registered_number]

Note

❒ If the -p option is added, you can view the settings one by one.

❒ Omitting the number displays all access settings.

Number 1 2

Community name public admin

IP address 0.0.0.0 0.0.0.0

Access type read-only

trap off

read-write

trap off
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❖❖❖❖ Community name configuration
You can set the community name of the Network Interface Board.

msh> snmp number name community_name

Note

❒ The community name must consist of 15 characters or less.

❖❖❖❖ Access type configuration
You can select the access type from those listed below.
msh> snmp number type access_type

❖❖❖❖ Protocol configuration
You should use the following command to set the protocols to active or inac-
tive. If you set a protocol to inactive, all access settings set to use that protocol
are disabled.

msh> snmp {ip | ipx} {on | off}

•  “on” means active and “off” means inactive

To change the protocol of an access settings, use the following command.
However, if you disabled a protocol with the above command, making it ac-
tive here will have no effect.

msh> snmp number active {ip | ipx} {on | off}

❖❖❖❖ Access configuration
You can configure the address of a host depending on the protocols used. 
The Network Interface Board accepts requests only from hosts having ad-
dresses with access types of “read-only” or “read-write”. Type “0” to have the
Network Interface Board accept requests from any host without requiring a
specific type of access.

Command syntax:
msh> snmp number {ip | ipx}address

Note

❒ To specify the TCP/IP protocol, type ip followed by a space and then the
IP address.

❒ To specify the IPX/SPX protocol, type ipx followed by a space and then the
IPX address followed by a decimal and then the MAC address of the Net-
work Interface Board.

Access type Type of access which is permitted

read Read only

write Read and write

trap User is notified of trap messages.

no All access is denied.



Appendix

98

7

The following is an example of how to configure registration number 3 with
the IP address 192.168.15.16.
msh> snmp 3 ip 192.168.15.16
The following is an example of how to configure registration number 3 with
the IPX address 7390A448, and the MAC address 00:00:74:62:5C:65.
msh> snmp 3 ipx 7390A448.000074625C65

IPP

Use the ipp command to configure the IPP settings.

❖❖❖❖ View settings
The following command displays the current IPP settings.

msh >ipp
Example output:

timeout=900(sec)
auth basic

• The “timeout” setting specifies how many seconds the computer keeps try-
ing to access the network printer to send print jobs when no connection
could be made.

• The “auth” setting indicates the user authorization mode.

❖❖❖❖ IPP timeout configuration 
Specify how many seconds to wait before canceling a print job if it has been
interrupted for some reason. The range of time can be changed between 30 to
65535 seconds.

msh>ipp timeout {30 -65535}

❖❖❖❖ IPP user authorization configuration
Use the IPP user authorization to restrict users that can print with IPP. The
factory default is “off”.

ipp auth {basic|digest|off}

• “basic” and “digest” are user authorization setting.

• “off” removes a user's authorization.

Note

❒ If you select “basic” or “digest”, see next sectionp.99 “Configuring IPP
user authorization” for how to configure the user name. Up to ten user
names are available.
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❖❖❖❖ Configuring IPP user authorization
Use the following command:

ipp user
The following message appears.

Input user number (1 to 10):
Type the number, user name and password.

IPP user name:user1
IPP password:*******"
After configuring the settings, the following message appears.

User configuration changed.

Changing the password

Use the passwd command to change the remote maintenance password.

Important

❒ Be sure not to forget or lose the password.

Note

❒ The default factory password is “password”.

AAAA Type “passwd”.

msh> passwd

BBBB Type the current password.

Old password:

CCCC Type the new password.

New password:

Note

❒ The password must consist of 3 to 8 alphanumeric characters and symbols.
Upper and lower case characters are considered unique. For example, R is
different from r.

❒ The password is the same as that used in the configuration of the Network
Interface Board using a Web Browser and that used in the NIB Setup Tool.
If you change a password from telnet, the other passwords are also
changed.

DDDD Type the new password once again.

Retype new password:
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Changing the NetBIOS name

Use the hostname command to change the NetBIOS name of the machine.

msh> hostname NetBIOS name of the machine

Note

❒ The NetBIOS name consists of up to 13 alphanumeric characters.

❒ You cannot use a name starting with “RNP” or “rnp”.

WINS

Use the wins command to configure the WINS server.

Reference

For how to configure the WINS server, see p.116 “Configuring a WINS Serv-
er”.

❖❖❖❖ WINS configuration
Use the set command to make WINS active or inactive.
msh> set wins {on|off}

• “on” means active and “off” means inactive.

❖❖❖❖ View settings
The following command displays the IP addresses of the WINS server.
msh> wins
Example output:
wins: primary server 192.168.10.1 secondary server
192.168.10.2
wins server current config: secondary server 192.168.10.1
secondary server 192.168.10.2 hostname 123456789abcd Sco-
peID

Note

❒ The current configuration appears on the second line when DHCP is ac-
tive. When DHCP is not active, there is no second line.

❒ If the network boot setting is changed to another from DHCP, the WINS
server IP addresses that were saved on the machine may differ from the
current IP addresses.

❖❖❖❖ Address configuration
Specify the WINS server IP addresses.
msh> wins {primary|secondary}IP_address
Use “primary” to specify the primary WINS server IP address, and use “sec-
ondary” to specify the secondary WINS server IP address.
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AutoNet

Use the set command to configure AutoNet.

Reference

For more information about AutoNet, see p.118 “Using AutoNet”.

msh> set autonet {on|off}

 •“on” means active and “off” means inactive.

Changing the password

Use the passwd command to change the remote maintenance password.

Important

❒ Be sure not to forget or lose the password.

Note

❒ The default factory password is “password”.

AAAA Type “passwd”.

msh> passwd

BBBB Type the current password.

Old password:

CCCC Type the new password.

New password:

Note

❒ The password must consist of 3 to 8 alphanumeric characters and symbols.
Upper and lower case characters are considered unique. For example, R is
different from r.

❒ The password is the same as that used in the configuration of the Network
Interface Board using a Web Browser and that used in the NIB Setup Tool.
If you change a password from telnet, the other passwords are also
changed.

DDDD Type the new password once again.

Retype new password:
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SNMP

The Network Interface Board functions as a SNMP (Simple Network Manage-
ment Protocol) agent using the UDP and IPX protocols. Using the SNMP man-
ager you can get information about the machine.

The factory default community names are “public” and “admin”. You can get
MIB information using these community names.

Reference

For more information about configuring the community name, see p.96
“SNMP” in “Remote Maintenance by telnet”.

Limitation

❒ The kinds of supported MIBs differ depending on the printer.

❖❖❖❖ Supported MIBs

• MIB-II

• PrinterMIB

• HostResourceMIB

• RicohPrivateMIB
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Understanding the Displayed Information 

This section describes how to read status information returned by the Network
Interface Board.

Network Statistical Information

Use the following command to view Network Interface Board network statistics.

Detailed information about the words used to describe the status of the Network
Interface Board are described below.

• mshell : Use the info command. See p.95 “Machine status”.

Item name Meaning

System elapsed time The time that has passed since the Network Interface Board start-
ed.

Total printing time The total time spent in processing the print data.

Total open count The total open (printing process) count that the application re-
quired.

Current connection count The current number of open connections with the Network Inter-
face Board.

Total connection count The total number of print jobs sent to the Network Interface 
Board.

Print error count The number of times the printing process sent an error message.

Access error count The number of times the connection was refused because of the 
access control value.

Print request full count The number of times a connection was refused because the 
number of print requests exceeded the number of allowed ses-
sions.
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Configuring the Network Interface Board

The Network Interface Board settings can be displayed and confirmed using the
commands below.

• mshell : Use the show command. See p.96 “Network Interface Board config-
uration settings information”.

Item name Meaning

Common

Mode

Protocol Up/Down

AppleTalk

TCP/IP

NetWare

NetBEUI

NVRAM version

Device name

Comment

Location

Contact

Soft switch

 

 

Up means active, Down means inactive.

 

 

 

 

Internal version number.

AppleTalk

Mode

Net

Object

Type

Zone

 

AppleTalk protocol in selection.

Network number.

Macintosh printer name.

The type of printer.

Name of the zone that the machine belongs to.
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TCP/IP

Mode

ftp

lpr

rsh

diprint

web

telnet

download

npmp

snmp

ipp

wins

EncapType

Network boot

Filter

Max DSTs

Address

Netmask

Broadcast

Gateway

AccessCtrl

AccessMask

Primary WINS

Secondary WINS"

Time server

Home page URL

Home page link name

Help page URL

SNMP protocol

 

Up means active, Down means inactive. 

 

 

 

 

 

 

 

 

 

 

 

Frame type.

Network boot.

Internal parameter.

Internal Information

IP address.

Subnet mask.

Broadcast address.

Default gateway address.

Access control address.

Access control mask.

Primary WINS server address

Secondary WINS server address

 

URL of homepage.

URL name of homepage.

URL of help page.

Protocol used with SNMP.

Item name Meaning
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NetWare

Mode

EncapType

RPRINTER number

RPRINTER name

Print server name

Fileservername

Context name

Switch

Mode

NDS/Bindery

Packet negotiation

Print job timeout

 

(this value is fixed)

Frame type.

Remote printer number.

Remote printer name.

Print server name.

Name of the connect file server.

Context of print server.

 

Active mode.

(this value is fixed)

 

Time of the job timeout.

NetBEUI

Mode

Switch

Mode

Directprint

Notification

Workgroup name

Computer name

Comment

Share name[1]

 

(this value is fixed)

 

(this value is fixed)

(this value is fixed)

Notification of print job completion.

Name of the workgroup.

Name of the computer.

Comment.

Share name (name of the printer type).

Shell mode Mode of the remote maintenance tool.

Item name Meaning
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Message List

This is a list of messages written to the machine's system log. The system log can
be viewed using the syslog command.

System Log Information

You can use the following methods to view the system log.

• mshell : Use the syslog command. See p.96 “System log information”.

Message when the Network Interface Board starts or restarts

Network Interface Board Ver.x.x.x The version number of the Network Interface 
Board.

PRINTER SYSTEM “system name” Ver.x.x.x The system name and version of the machine.

Attach FileServer=“file server name” The machine is attached to “file server name” 
as the nearest server.

Current Interface Speed:xxxMbps The speed of the network (10 Mbps or 100 Mb-
ps).

Current IPX address The current IPX address.

Frametype=“frame type name” The “frame type name” is configured to be 
used on NetWare.

NetBEUI Computer Name=“computer name” The NetBEUI Computer Name is defined as 
“computer name”.

Start httpd The Web server has been started.

Start npmpd for IPX The npmpd for IPX protocol has been started.

Start npmpd for TCP/IP The npmpd for TCP/IP protocol has been 
started.

Start smbd direct print mode(NetBEUI) You can print from a client on the Windows 
network via the print server.

Start snmpd Ver.2.0 The SNMP agent of the displayed version has 
been started.

Vendor= , Country= , Lang= The vendor, the country code, and the lan-
guage.
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NetWare (When the Network Interface Board is started)

❖❖❖❖ When working as a print server

❖❖❖❖ When working as a remote printer

Access to NetWare server “file server name” 
denied. Either there is no account for this 
print server on the NetWare server or the 
password was incorrect.

Cannot log in to the file server. Confirm that 
the print server is registered on the file serv-
er. If a password is specified for the print 
server, delete it.

Attach to print queue “print queue name” Attached to the print queue.

Login to fileserver “file server name” 
(“NDS|BINDERY”) 

Logged in to the file server with NDS or 
BINDERY mode.

Open log file “file name” The specified log file has been opened.

Printer “printer name” has no queue The print queue is not assigned to the ma-
chine. Using NWAdmin, assign the print 
queue to the machine, and then restart it.

Print queue “print queue name” cannot be 
serviced by printer 0, “print server name”

Print services are not available for the print 
queue. Confirm that the volume of the print 
queue exists on the specified file server.

The print server received error “error 
number” during attempt to log in to the net-
work. Access to the network was denied. 
Verify that the print server name and pass-
word are correct.

Cannot log in to the file server. The print 
server is not registered or the password is 
specified. Register the print server without 
specifying a password.

Cannot create service connection Cannot establish a connection with the file 
server. Your request may exceed the maxi-
mum number of connections that the file 
server can deal with at a time. 

Cannot find the printer (“print server 
name”/”printer number”)

The printer having the number displayed on 
the print server does not exist. Confirm the 
number of the machine registered to the 
print server.

Establish a connection with the print server, 
“print server name”

A connection with the print server has been 
established.

No local target for “print server name” Cannot get routing information about the file 
server. If a different frame type is configured 
from that used on the network, you should 
select “Auto Select” as a frame type.

Required file server (“file server name”) not 
found

Cannot find the required file server.

Could not to attach to print server (“print 
server name”)

Cannot connect to the print server. The print 
server refuses a connection for some reason. 
Confirm the configuration of the print serv-
er.
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NetBEUI (When the Network Interface Board is started)

TCP/IP

❖❖❖❖ When the address is configured

❖❖❖❖ When using lpr 

At the beginning of the message, the IP address of the client is displayed with-
in parentheses.

Back to default name (<Computer name>) The same computer name is detected on the 
network. As unable to add computer name to 
the suffix, the computer name back to default 
name. Configure a new computer name that is 
unique.

Print session full Cannot accept the print session.

Required computer name (<Computer 
name>) is duplicated name

The same computer name is detected on the 
network. The start job determines the compu-
ter name by adding the computer name to the 
suffix (0,1....). Configure a new computer 
name that is unique.

Invalid gateway address The gateway address is not correct for the 
specified IP address.

filter data error Some data cannot be handled by the filter 
option. Confirm the file code and the settings 
of the filter option. 

lost connection The connection was cut by the other party. 
Check the machine to which you requested 
to print.

print requests full Cannot accept the print request (max. 5 ses-
sions). Confirm the status of the machine 
with lpq, rsh, rcp or ftp, and print it again af-
ter the print request becomes less than 5 ses-
sions.

However, the maximum request when using 
ftp command is 3.

printer permission denied Cannot get permission to use the machine. 
Confirm the access rights with the access 
control address and the access control mask.

printer refuse Something is wrong with the machine. Con-
firm the status of the machine.
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❖❖❖❖ When using rsh, rcp, ftp

At the beginning of the message, the IP address is displayed in parentheses.

Can't build data connection: “message” Cannot establish a connection for data trans-
fer due to the displayed error. Check the ftp 
of the workstation that requested the print 
job, and start it again. When using ftp, this 
message remains only on the system log in-
formation. 

cmd_name:Command not supported The remote shell command using cmd_name 
is not supported. You should use only the 
print, stat, syslog and info,  commands. You 
should access the machine only with rsh and 
rcp remote shell commands.

command line too long The command line is too long.

file_name:No such file or directory You must use a file name with the srat, sys-
log, info and instal commands.

filter data error Some of the data cannot be handled with the 
filter option. Confirm the file code and the 
settings of the filter option.

get log busy Another machine is getting the log informa-
tion. You should get it afterwards.

lost connection The connection was cut by the other party. 
Check the ftp of the workstation that re-
quested the print job, and start it again. 
When using ftp, this message remains only 
on the system log information. 

no more ftp execute More than three users at a time cannot log in 
using ftp. Since there are three other users 
that have already logged in, wait until the 
job is finished.

print requests full Cannot accept the print request.(max. five 
sessions) Confirm the status of the machine 
with lpq, rsh, rcp, and ftp commands, and 
print it again after the number of print re-
quests (sessions) becomes less than five.

However, the maximum request when using 
ftp command is 3.

printer busy Cannot get the machine information. Anoth-
er user may be accessing it. Wait a few min-
utes before trying again.

printer permission denied Cannot get a permission to use the machine. 
Confirm the access right with the access con-
trol address and the access control mask.

printer refuse Something is wrong with the machine. Con-
firm the status of the machine.
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❖❖❖❖ When using SNMP

Error numbers in the messages are codes for internal use.

❖❖❖❖ When using DHCP

Exit snmpd The agent is complete. Reset the machine or 
turn the machine off and on.

recvfrom:packet discarded,length(Reception 
packet length)> (Packet size),from addr <Ad-
dress of partner point>

The received packet was ignored since the 
length of the packet exceeds the limit. Con-
firm whether the administration station sent 
a packet is longer than 1025 bytes.

session <Community name appointed> not 
defined

The community name of the received packet 
is not defined. Confirm that the community 
name of the administration station is the 
same as that specified for the machine.

snmpin:Bad use of session <community 
Name> from <Address>

The community name of the received packet 
is not the same as that of the administration 
station. Confirm the community name spec-
ified to the machine. 

snmpin:error in snmpdecipher,code (<Error 
number>)

An error occurred with the received packet. 
Check if the number of the objects sent from 
the administration station is more than 31 
and if there are wrong MIB requests.

snmpin:error in snmpservsend,code (<Error 
number>)

Cannot send a response packet. Normally, 
this message is followed by the messages.

snmpin:pkt too large,code (<Error number>) The response packet to the request is too big 
to send. Reduce the number of the objects 
per request. 

nmpin:error in sending too large request 
back,code (<Error number>),giving up

The packet notifying the error is too big to 
send. Reduce the number of the objects per 
request.

snmpin:received bad version The version of the received packet is invalid. 
Confirm that the version of the administra-
tion station is version-1(0).

Connected DHCP Server(<IP address as-
signed by the DHCP server>)

The IP address is assigned by the DHCP 
server.

Current IP address(<Current IP address>) This IP address assigned by the DHCP serv-
er is used.

DHCP lease time is infinity Lease time of the IP address assigned by the 
DHCP server is infinity.

Auto-configured IP address(<Current IP ad-
dress>)

This IP address assigned by AutoNet is 
used.
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❖❖❖❖ When using WINS

The Error number is the number that is sent in response to the WINS server
error code.

WINS name registration/refresh error 
code=<IP address of the WINS server> Net-
BIOS Name=<NetBIOS name>

Registering the NetBIOS name of the ma-
chine with the WINS server is complete.

WINS server address 0.0.0.0 The WINS server IP addresses are not speci-
fied. Specify the IP addresses.

WINS name registration/refresh error code 
(Error number)

Cannot register or refresh the NetBIOS 
name of the machine with a WINS server.

Check if the WINS server IP addresses are 
specified correctly.

Confirm that WINS server is available.

Configure a new NetBIOS name that is 
unique.

WINS name registration: Server No Re-
sponse

WINS wrong scopeID

There is no reply on registration or refresh 
request from the WINS server.

Check if the WINS server IP addresses are 
specified correctly.

Confirm that WINS server is available.

WINS wrong scopeID The wrong scope ID is used.

Configure the correct scope ID.
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Precautions

Please pay attention to the following when using the Network Interface Board.
When configuration is necessary, follow the appropriate procedures below.

Connecting a Dial Up Router to a Network

When the NetWare file server and the machine are on the opposite side of a rout-
er, packets are continuously sent back and forth, possibly causing communica-
tion charges to increase. Because the packet transmission is a specification of
NetWare, you need to change the configuration of the router. If the network you
are using does not allow you to configure the router, configure the machine.

Configuring the router

Filter the packets so that they do not pass over the dial up router.

Note

❒ The MAC address of the machine doing the filtering is printed on the system
configuration list. For more information about printing the system configura-
tion list, see p.119 “System Configuration List (Network Configuration)”.

❒ For more information about configuring the machine if the router cannot be
configured, see the instructions below.

Configuring the machine with NetWare

AAAA Following the setup method in this manual, configure the file server.

BBBB Set the frame type for a NetWare environment.

Reference

For more information about selecting a frame type, see Printer Reference 1.

Configuring the machine without NetWare

AAAA While not printing, the Network Interface Board sends packets on the net-
work. Set the NetWare to inactive.

Reference

For more information about selecting a protocol, see Printer Reference 1.



Appendix

114

7

PostScript Printing from Windows

When printing PostScript from Windows, see Printer Reference 2 for how to con-
figure the Network Interface Board and printer driver.

NetWare Printing

Form Feed

You should not configure the form feed on NetWare. The form feed is controlled
by the printer driver on Windows. If the NetWare form feed is configured, the
machine might not print properly. If you want to change the form feed setting,
always configure it on Windows.

• With Windows 95/98/Me, clear the [Form feed] check box on the [Printer Set-
tings] tab in the [Printer Properties] dialog box.

• With Windows 2000, clear the [Form feed] check box on the [Netware Settings]
tab in the [Printer Properties] dialog box.

• With Windows NT 4.0, clear the [Form feed] check box on the [Netware Settings]
tab in the [Printer Properties] dialog box.

Banner Page

You should not configure a banner page on NetWare. If you want to change the
banner page setting, always configure it on Windows. 

• With Windows 95/98/Me, clear the [Enable banner] check box on the [Printer
Settings] tab in the [Printer Properties] dialog box.

• With Windows 2000, clear the [Enable banner] check box on the [Netware Set-
tings] tab in the [Printer Properties] dialog box.

• With Windows NT 4.0, clear the [Enable banner] check box on the [Netware Set-
tings] tab in the [Printer Properties] dialog box.

Printing after resetting the machine

After resetting the remote printer, it will be cut off from the print server for about
30-40 seconds before connecting again. Due to the NetWare specification, print
jobs may be accepted, but they will not be printed during this interval.

When using the machine as a remote printer, wait about 2 minutes after resetting
the machine before attempting to print. 
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When Using DHCP

Note the following points when using DHCP (Dynamic Host Configuration Pro-
tocol).

Supported systems

Windows 2000 Server, Windows NT Server 4.0 and NetWare 5 can be config-
ured as a DHCP server.

Configure the machine with a reserved IP address

To always assign the same IP address, configure a reserved IP address using the
DHCP server.

Note

❒ When multiple DHCP servers are used, reserve the same address with each
DHCP server. The Network Interface Board needs to receive information
from the DHCP server that it contacts.

Follow these steps to configure the machine with a reserved IP address.

AAAA Start the DHCP manager.

BBBB Select the scope that will be used, and on the [Scope] menu, click [Reserva-
tion].

CCCC Type the IP address into [IP Address].

DDDD Type the MAC address of the Network Interface Board into [Unique Identifi-
er].

Note

❒ Do not use hyphens to separate the numbers.

❒ If you do not know the MAC address, it can be found on the system con-
figuration list. See p.119 “System Configuration List (Network Configura-
tion)”.

EEEE Type a name and comment into the [Client Name] box and the [Client Comment]
box.

Note

❒ For more information about client names, see p.116 “Additional informa-
tion”.

FFFF Click [Add].

An IP address is reserved.

GGGG Click [Close] to close the dialog box.



Appendix

116

7

Additional information

• When you click [Active Lease] on the [Scope] menu of DHCP manager, a list of
client leases appears. When the reserved IP address is not active, the name of
the reservation is the name entered in the Client Name field of the Add Re-
served Clients dialog box. When the reserved IP address becomes active, the
client name changes to the printer name configured by the Network Interface
Board. Only the first 13 letters of the printer name appear here. When you use
the machine with SmartDeviceMonitor for Admin, use the host name of the
machine as the [Client Properties] Client Properties dialog box.

• When the DHCP server does not assign an IP address, the Network Interface
Board uses 11.22.33.44 as a temporary IP address. You can confirm the ma-
chine's IP address on the system configuration list.

• Because 11.22.33.44 is a special IP address, you cannot print using this ad-
dress.

• When using the DHCP relay agent in a network environment that uses a dial
up router to connect to the Network Interface Board, an increase in commu-
nication fees can occur.

Configuring a WINS Server

The machine can be configured to register its NetBIOS name with a WINS server
when power is turned on. This enables the NetBIOS name of the machine to be
specified from SmartDeviceMonitor for Admin even in a DHCP environment.

This section describes how to configure the WINS server.

Note

❒ WINS Server is supported with Windows NT 4.0 Server Service Pack 4 or lat-
er, and Windows 2000 Servers WINS Manager.

❒ For more information about settings of WINS Server, see Windows Help.

❒ If there is no reply from the WINS Server, the NetBIOS name will be regis-
tered by broadcast.

❒ The NetBIOS name consists of up to 13 alphanumeric characters.

Using a WWW browser

AAAA Start the Web browser.

BBBB Point your browser at the URL or IP address of the machine (e.g. “ht-
tp://XXX.XXX.XXX” substituting the Xs with the IP address).

The status of the machine you chose appears on the Web browser.

CCCC Click [Network Config.].

The dialog box for entering the password and user name is displayed.
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DDDD Enter your user name and password, and then click [OK].

To use the factory default account, enter no user name and type “password”
for the password.

EEEE Click [TCP/IP].

FFFF Set [WINS] to active and enter the IP address of the WINS server in [Primary
WINS Server] and [Secondary WINS Server].

GGGG Click [Refresh].

HHHH Exit the Web browser.

IIII Restart the machine.

Using telnet

AAAA Connect to the remote printer using telnet.

BBBB Use the set command to make WINS active.

msh> set wins on

CCCC Specify the IP addresses (primary and secondary) using the following com-
mands.

msh> wins primary IPaddress

msh> wins secondary IPaddress

Note

❒ To confirm the current configuration, use the show command.

DDDD Log off from telnet.

EEEE Restart the machine.

Using DHCP

You can use the machine under a DHCP environment. You can also register the
printer NetBIOS name on a WINS server when it is running.

Note

❒ Printers that register their NetBIOS name on a WINS server must be config-
ured for the WINS server.

❒ Supported DHCP servers are Windows NT 4.0 Server Service Pack 4 or later,
Windows 2000 Server and NetWare 5.

❒ If you do not use WINS server, reserve machine's IP address in DHCP server
so that the same IP address is assigned every time.
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❒ DHCP relay-agent is not supported. If you use DHCP relay-agent on a net-
work via an ISDN line, it will result in expensive line charges. This is because
your computer connects to the ISDN line whenever a packet is transferred
from the machine.

Using AutoNet

If the machine's IP address is not assigned by a DHCP server automatically, a
temporary IP address starting with 169.254 which is not used on the network can
be selected automatically by the machine.

Note

❒ The IP address assigned by the DHCP server is given priority to that selected
by AutoNet.

❒ You can confirm the current IP address on the system configuration list.

❒ When AutoNet is running, the NetBIOS name is not registered on the WINS
server.

When Using the NIB Setup Tool

If the Network Interface Board cannot browse using the TCP/IP protocol, con-
firm that the TCP/IP environment is correctly configured in your computer.

When Using IPP with SmartDeviceMonitor for Client 

When using IPP with SmartDeviceMonitor for Client, note the following:

• The network printer can only receive one print job from SmartDeviceMonitor
for Client at a time. While the network printer is printing a job, another user
cannot access the network printer until it completes the job. In this case,
SmartDeviceMonitor for Client tries to access the network printer until the re-
try interval expires.

• If SmartDeviceMonitor for Client cannot access the network printer and times
out, SmartDeviceMonitor for Client stops sending the print job. In this case,
you should cancel the paused status from the print queue window. SmartDe-
viceMonitor for Client will resume access to the network printer. You can de-
lete the print job from the print queue window, but canceling a print job that
has been printed by the network printer might cause the next print job sent
from another user to be incorrectly printed.

• If a print job that is sent from SmartDeviceMonitor for Client is interrupted
and the network printer cancels the job because something went wrong,
launch the print job again.

• Print jobs sent from another computer do not appear in the print queue win-
dow regardless of the protocol.
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• If various users send print jobs using SmartDeviceMonitor for Client to net-
work printers, the printing order might not be in the order in which the jobs
were sent.

• An IP address cannot be used for the IPP port name because the IP address is
used for the SmartDeviceMonitor for Client port name.

System Configuration List (Network Configuration)

You can confirm the network information on the system configuration list.

AAAA Confirm that the machine is online.

BBBB Print the system configuration list.

Reference

For more information about printing the system configuration list, see
Printer Reference 2.

Note

❒ The following configuration list is an example of Type 80. Some of contents
are different when printed by Type 40.
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1. TCP/IP

IP Address

Subnet Mask

Gateway Address

Access Control

Access Mask

Network Boot

ActiveProtocols

Ethernet

2. MAC Address

3. Printer Name

4. NetWare

Operation Mode

Print Server Name

Frame Type

File Server Name

NDS Context Name

5. NetBEUI

Workgroups Name

Network Path Name

6. AppleTalk

Printer Name

AppleTalk Type

AppleTalk Zone
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